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About SimLab Composer

 

 



 

 

 

Since the foundation of Simlab Soft, it's mission was clearly defined as developing state-of-the-art 3-D software that is affordable, fun and easy to use;
represented in SimLab Composer with the vision in mind of making 3-D for all.
 
SimLab Composer is a 3-D Computer Graphics (CG) software for making images, animation and simulations. It was developed by Simulation
Lab Software L.L.C.It is frequently used in video game development, TV commercial, architectural visualization, and engineering.
 
More precisely, SimLab Composer is an interior (indoor) and exterior (outdoor) 3-D scene building, sharing, rendering, baking, animation, automation,
simulation, and exhibition application. It supports importing native and standard 3-D file formats to build scenes, that can be yet exported into many
file formats.
 
SimLab Composer is built from multiple workbenches that match all your needs. The workbenches, developed so far, are Scene Building Workbench,
Sharing Workbench, Rendering Workbench, Interior Workbench, Texture Baking Workbench, Animation Workbench, Simulation Workbench, Automation
Workbench, and Exhibition Workbench. The GUI (Graphical User Interface) of SimLab Composer is designed to be very easy to use, which requires a short
learning curve for exposing the application functionalities and capabilities.
 
With each new release of SimLab Composer, SimLab Soft aims to make their partners and clients around the world happier and more satisfied, though
providing them by the right 3-D tools, helping to achieve their success fast and within budget. The latest version of SimLab Composer involves new
features, in addition to enhancements and improvements to the previous features that are already included in the previous versions of SimLab Composer.
 
The manual is divided into two chapters, each of which is further divided into relevant topics. Each chapter relates to the most important concepts in
SimLab Composer.



 

 

Icons Used in This Manual
  

To make your experience with the manual easier, you'll find a handful of icons at the left margin of the manual to indicate particular points of interest.

The Tip icon points out interesting techniques, helpful information, or hints that is likely to make your job easier.

The Remember icon is a friendly cue about things to keep in mind when performing certain tasks, or important information that can benefit you in
understanding how SimLab Composer works.

Paragraphs marked with this icon include important information that will help you avoid common mistakes and steer clear of trouble.

Occasionally, we include some technical information that, while interesting to some, is not essential reading for everyone.

The on the web icon calls your attention to useful material that you can find online.

The example icon alerts you to some really cool examples illustrating techniques and issues.



 

 

The video icon alerts you to very useful tutorial and demo videos in our Youtube channel.

The Tutorial icon alerts you to very useful written tutorials.

The Script icon alerts you to very useful Scripting for Composer.



 

 

What's New
 

 Features in SimLab Composer 9.1
 A brief summary with regards to the new updates that have been made in SimLab Composer 9.1:
  
 SimLab Composer:
 Scene Building

 

•  VR Package Importer and Exporter:
•  Self extracted EXE exporter:
•  Replace and align models:
•  Tree transparency:
•  Rename objects on double click:
•  Apply Camera on double click:

  
 HTML/WebGL Exporter

 
•  Sun Environment
•  HDR Environment
•  Full Screen mode

  
 VR Workbench

 
•  Create Multiple 360s renders from the VR viewer.
•  Training Builder.
 

  
 Renders
 •  Add two output render image sizes (2560x1440 and 3840x2160)
  
 Automation
 •  Visual Scripting.



 

 

  
 SimLab Free VR Viewer:

https://youtu.be/zt-95ZLwkpg
https://youtu.be/zt-95ZLwkpg


 

 

 

 
•  VR Measurement mode (measuring distance VR environment)
•  VR Web Browser
•  VR Catalogs

https://youtu.be/UPPoj3gyfA0
https://youtu.be/UPPoj3gyfA0


 

 

•  Video Action/Response
•  VR Note
•  New viewer menu: Loading and importing in the viewer, normal scene loading, importing model to an existing scene,new SimLab action
for loading and importing
•  New GUI for desktop and VR in the viewer
•  Material Editor in the viewer
•  Environment Editor in the viewer

  
 SimLab Showroom:

 
•  Number of packs for the showroom users 5 to 30 in each catalog (private and public)
•  Images resizing and adding button in case the user have one model which will guide him directly
•  New command line to handle downloading and starting package and executables

  
  
  

https://youtu.be/UY1ygh9cgS0
https://youtu.be/UY1ygh9cgS0


 

 

Composer GUI
 

 SimLab Composer interface is based on selecting the workbench icon to work on. Upon selecting the workbench the allocated tools in that workbench
will appear next. Primary tools, properties, task, and navigator panel in the interface will be changed to display the defaults of that selected workbench.

 On the left hand side of SimLab Composer interface, from the workbencÑh icon the user can select the workbench to use. Each one refers to a
workbench in SimLab Composer. The workbenches will be active according to available license(s).

 
There are several elements that provide structure to how the commands are presented in the user-interface, as shown below. Shown in red are the
Accessibility Toolbar, shown in green are the Specific Tools, and in blue is the workbenches Icon. Also as shown below, the application interface has
different sections.



 

 

                          

  



 

 

Workbench Icon
 

 From the workbench icon the user can select the workbench to use. The workbenches in this icon will be available based on the acquired license. The
available workbenches are as listed below, and each application and its corresponding functionalities are described in separate sections.

  
 Workbench icon consists of two parts; the icon and a drop-down menu.
  



 

 

 



 

 

Specific Tools
 

 Once you select a workbench, the specific tools allocated in that workbench will appear next to the scene building primary tools.

 
 
The concept of additive tools helps orienting the user towards the appropriate tools without the cost of losing access the primary tools. SimLab
Composer tools are arranged into menus depending on their nature of use.

 
As an example, clicking on the “move” icon, will display a menu of tools associated with the movement of an element, you can translate, rotate or
scale an object among other operations via that menu.
 

 

 



 

 

Object Tree
 

  
On the left side of SimLab Composer, you can find the objects tree, the tree displays and arrange all the elements in your scene,
including, geometries, lights and cameras to name a few.

  
 

 1 Collapse Tree
2 Expand all objects from parents
3 Collapse all objects from parents
4 Switch font color black/white



 

 

5 Search for Objects by name
6 Align Object

7 Resize the object tree
8 Parent
9 Object

  
 You can adjust the size and the location of the tree easily, as well as choosing whither to hide it or not.

  
 



 

 

  
 Selecting an object will display the attributes box that contains all the properties for the selected object, through this panel you can perform several

basic operations on the object,
among which, are: translate, rotate, isolate and copy, In Composer 9, user can search for objects by name.

  

Sometimes this Object Tree displays application specific functions, like Render Settings, when the Rendering workbench is selected.



 

 

Accessibility Toolbar
 

 
Regardless of the selected workbench, this toolbar will be displayed at the bottom of the 3D area. This toolbar contains several functions that controls
the behavior and appearance of the 3D area, as well as several tools for navigation and selection. It provides the user with different functions to set the
view of the 3D are, as described below starting from left to right.

  

 

 Select Object ( Pick Mode)

 
When starting SimLab Composer the default picking mode is enabled. Picking returns two values; a location and a normal direction. The user can change
the picking mode to the following:
 

 

 The picking modes in SimLab Composer are:

 
 
1. Default Pick: in this mode the user picks a point in the model. The location and the normal direction at that point are returned. The geometry at the
picked location will be selected in the Object Tree, and its bounding box will be displayed in the 3D area.



 

 

 
2. Pick Edge End Point: this picking mode will highlight the edge closest to the selected point, and the returned normal will be tangent of the curve at
the closest end.
 
3. Pick Edge Loop: this picking mode is useful for selecting the center of a loop.
 
4. Pick Center Of Curvature: with this picking mode picking a curve will highlight the curve, and will display its center normal .
 

 Window Configuration
 This button allows the user to select the number of views, in the 3D area. The user can select to have:

 

 Views can also be displayed by pulling the right and bottom edges of the 3D area.

 
 
View Mode

 The default view mode in SimLab Composer is the Solid View. It displays models in solid view with edges hidden. The user can select one of the
following view modes in SimLab Composer.

  

 

Button Effect Shortcut
X Ray View Alt + 1

Edge Only View Alt + 2

Solid Illustration View Alt + 3



 

 

Solid View Alt + 4

Real Time F4

 

 
1. XRay View; gives a x-ray effect to the models in the scene.
2. Edges Only View; displays only the edges of the models, in the scene.
3. Solid Illustration View; displays models in solid view, with their edges illustrated.
4. Solid View; displays models in shaded solid view.
5. Real Time; starts real time rendering for the 3D models in the scene
 

 
 
Default View Behavior

 This function sets SimLab Composer to default behavior in, which is described in the following table.
  

 

Navigation Mouse Button
Pan Middle mouse button
Rotate Left mouse button
Zoom Right mouse button

 
 
Rubber band

 This function can change the selection mode in the 3D area and it has three options:

 

 
# Rubber Band Selection: Changes the selection icon to a square band, and allows the user to window select more than one geometry in the 3D area.
# Append To Current Selection: The selection icon will show a ‘+’ sign inside the square band. The user can window select more geometry in a different
section of the 3D scene, without losing the previous selection.
# Remove from Current Selection: With a ‘-‘ sign added to the band, the user can remove geometry form selection, without losing previous selections.

 
 
Camera Pan

 This function changes the behavior of the left mouse button, to Pan.

 
 
Camera Zoom



 

 

 This function changes the behavior of the left mouse button, to Zoom.

 
 
Fit all

 This function automatically updates camera to fit all geometry in the scene within the active view area.

 
 
Zoom to Object

 This function updates the camera in the active viewport, to zoom to the selected object. In case the user presses the button without selecting an object,
a message will be displayed on top of the Common Toolbar asking him to do so.

 
 
Switch Between Parallel and Perspective View

 This function switches the camera between perspective and parallel modes, in the active viewport. For engineers who are used to parallel mode, this
option would be helpful.

 
 
Capture View image

 This function allow user to capture image from the scene.
 

  



 

 

Navigator Panel
 

 

Towards the bottom of the interface, you can find Simlab Composer's navigator panel, this panel grants the user access to all the predefined elements
available in Simlab Composer. Elements such as materials, HDR images, 3d models can be found in the libraries. An extensive set of predefined materials can
also be accessed through the navigator panel.
 

 In addition to the elements, SimLab Composer provides through this panel an access to the user created elements, some of which are scene states,
walkthroughs and animations.

  

 



 

 

Materials Library
 

 
In addition to the elements SimLab Composer provides, this panel offers access to the user created elements, some of which are scene states,
walkthroughs and animations.
 

 

 
 
Material Panel

 In this panel, the user will have five buttons, as shown in the material panel image below.

 

 Add New Material
 Clicking this button will add a new item to the corresponding library. 

 
 
Delete Material

 This button will delete the selected item from the library



 

 

 
 
Manage Material

 Clicking this button will display the Manage Library dialog, where the user can add new library(s), rename or delete existing ones.
 

 

 

 
The Manage Material Libraries dialog has more options. SimLab Composer, by default, comes with Composer materials library that has different
groups/materials types. In this dialog the user can export, import, or merge different material libraries. Material libraries will be exported in
(*.mlb) file format, and the packed libraries to import should have the same file extension.

 
 
Share Contents

 With this feature, sharing different resources is simplified significantly. The rule is clear: if a resource exists in a library, then it can be shared.

 

 
Resources can be:

•  Materials
•  HDRs
•  Models
•  Background Images



 

 

•  And even more...

 
 
To share a resource, just drag and drop it from a library panel to the area with the title Drop to Share and surrounded by orange dotted border,
which is located on the panel of  Sharing Resourced tab. This procedure is shown in the following image:

 

 
Sharing Resources tab includes the following control elements, as shown in the following image:
 

•  Drop to Share: It is an area where the user should drop in a resource.
•  Save Package: It is a button that let you to export and save a package to be shared with colleagues or sent to SimLab team.
•  Load Package: It is a button that let you to import a package into SimLab Composer.
 

 

 

 
The Sharing Resources tab displays a green tick (as shown in the following image) once an item is dropped into Drop to Share Area, indicating the
 operation is successfully finished.
 

 



 

 

You can include items of different types in same package.

 
 
Change View

 The user can select the size of the items in the library (Large, Medium, or Small), as shown in the following image:

 

  

Changes to SimLab Composer's GUI are saved when the user closes composer.

  



 

 

Libraries
 

 
In this panel grants the user access to all the predefined elements available in simlab composer, elements, such as materials, HDR images,
 3D models can be found in the libraries.
 

 

  



 

 

3D Models Library

 

 
The library panel, on the other hand, will change to show the Basic Shapes, Composer Scenes. This library provides users with quick access to
frequently
used 3D models. In this panel the user can add new items to the Basic Shapes group, and can delete others. Clicking the Manage Library button,
enables
the user to create new groups and manage existing ones, also can change the library view.

 

  

 Download Contents
 

 

 

 
The user can separately download each downloadable content one at a time by double-clicking a downloadable content from the desired library, if
the Downlad
Content dialog box appears as shown in the following image.

  



 

 

 

  

 

 

 
The user can also download all contents related to the active library at once only in a single step by pressing the Download All Contents button
(as shown in the following image) that appears on the Library toolbar. The Library toolbar is a vertical toolbar located at the left side of a Library
as shown in the following image. The Download All Item dialog box (as shown in the following image) appears once the Download All Items
 button is selected.

 

  



 

 

 

After the download process is successfully completed, the new item(s) will be directly available in the corresponding library without the need to
 restart the Composer application.

  

Downloadable contents are available online, therefore an Internet connection is required in order to benefit from this feature.

  



 

 

Rendering Library
 

 
Background Image

 This background setting option requires the user to browse to an image file to be used for the background of the rendered image.
 

 

 
 
Background Spherical

 

Spherical Background; enables the user to select (*.hdr), (*.exr), or any image file, that will be wrapped around a sphere or hemisphere, and select color,
size and brightness. This option is added to give users more control since the Environment-HDR (global HDR) in the Render Settings dialog can be
rotated, but cannot be scaled.
The user can click the Image in the Render Settings dialog, and browse to an HDR image file.
Then by clicking the ‘+’ Add to HDR library button, the current image will be added to the library. A unique name should be given to each HDR image.
 

 

 
 
Presets

 

 In the image shown below different settings where changed in the Render, Environment, and Background task bars that resulted in the rendered image shown.
Clicking the add button in the render settings library, displays the Add New Item dialog. The name and preview image for the rendering can be entered,
in this dialog. This will add the preview image to the library.
 



 

 

 

  
 Sun

 
This environment setting simulates physical sky at different sun angles (Solar Elevation), which determines the time of the day. The sliders of the parameters
of this environment option, makes it easy for the user to view the effect of each parameter, in real time.
The user can select to Enable Sun, in the render settings, in addition to enabling the HDR. The result will give the rendered image the sun shadow effect.



 

 

IES Lights Library

 

 
3-D interior and home design just reached a whole new level thanks to this new light category. Now, SimLab Composer supports IES data, an
important factor for architecture visualization. Using IES light in your interior scenes can appears and produces more photo-realistic, as actual
lighting effects are more realistically emulated. The IES Light Library in SimLab Composer (as shown in the following image) contains a
collection of 29 pre-installed IES lights and all of them can help you generate a nice ambience lit interior environment for your renders.
 

 

 The panel of the IES Light Library is located vertically at its left-side, presenting the following six buttons:

 

 
#  Add New Item: The Add New Item button allows the user to add new IES Light selected from the scene to any activated light tab within the IES
Light Library. When this button is clicked, the Add New Item dialog box appears.
#  Delete Item: This command discards the selected light thumbnail from the panel of the activated tab.
#  Manage Library: The Manage Library button launches the Manage Library dialog box o give the user options to create, delete and rename light
 groups which are presented by tabs in the IES Light Library.
# Download Contents: This task is the same as in the 3D Models Panel described in Navigator Panel.
# Share Contents: This task is the same as in the Material Panel described in Navigator Panel.
# Manage Material :This task is the same as in the Material Panel described in Navigator Panel.

  

Lighting is perhaps the most important aspect of CG. It really makes or breaks a scene. Once your lighting is ready, you will be able to render the scene.

  



 

 

Animation Library
 

 
Time Line provides the user with a tool to visualize and edit animation key frames. The time line is displayed by default in the Library panel of
the Animation workbench.

  
In the timeline the user can also set the animation duration, by setting the end key frame value.

 

 
The current frame is marked on the time line by a red vertical line. The names of the animated objects appear on the left part of the time line,
clicking on the name of any object automatically selects it in the 3D area.
 

 
The user can play animation by clicking the Play Animation button in the animation time line, or by hitting the Space Bar. The tool bar also
includes the tool buttons Go to First Frame (Shortcut Home) and Go to Last Frame (Shortcut End).
 

 

  
It also includes the Director Record button, which can be used for managing animations from multiple cameras

 
 
Clicking on an animation key frame on the time line will show its properties, in the Properties panel. The user can change these properties, for
different types of animation.

  
The user can also change the location of any key frame on the time line, by selecting then dragging it from a location to another.



 

 

 

 
 
The user can drag a selection box to copy multiple key frames. The user can delete all the key frames by clicking the Delete All Animations tool
button in the time line.

  

 
In this Panel the user can copy ,move, delete or delete all the key frames in the animation timeline, by clicking the corresponding button. The user
can also scale the time line.
 

 

  



 

 

Scene State Library
 

 
Scene States enable users to capture different configurations for the selected 3D model(s), or for the whole scene.
 

 

 The User can check the properties to include in a scene state, from the Default Apply group in the task bar.

  
SimLab Composer’s Scene States are smart in capturing attributes; they can include any combination of the listed attributes.

 This can be helpful in creating scene states for models with different attributes, and setups. If the user needs to show different products with different
materials or versions, SimLab smart scene states are the answer.

  



 

 

Sequence
  

VR Animation Sequences: Utilize animation sequences in your scenes and projects.

  
 In the timeline the user can create interactive sequences that can be implemented in the VR experience in the Simlab Viewer
  

 

 •  Create an Animation Sequence: by clicking on this icon the user can create new sequence to use in your scenes.
•  Show Animation Sequence List: This function button displays the list of sequences you created.

  

Utilize and employ Animation Sequences in your exported 3D PDF files or WebGL/HTML files; either by assigning them to any 3D object
via SimLab Composer or to 2D elements of your templates via SimLab Template Designer.



 

 

VR Animation Sequences video tutorials:

 

https://www.youtube.com/watch?v=IGpHB-0_eX8
https://www.youtube.com/watch?v=IGpHB-0_eX8


 

 

Properties Panel
 

 
When geometry is selected in the 3D area in any workbench, this panel will display four tabs describing the selected geometry. The user can change
the properties in this panel as following:

  

 

 Object Tab:
 In this tab the user can change the selected object name property. Other object properties that can be set in this tab include:

 

 
#  Hide/Show: by clicking this icon the user can hide/show the selected object in the 3D area. These two functions are available in the Object tab of
the Scene Building workbench.
#  Freeze/UnFreeze: freezing the selected object will lock its position/orientation in the 3D area. All transformation functions will NOT be applicable to
it, until this icon is clicked again to unfreeze it. These two functions are available in the Object tab of the Scene Building workbench.



 

 

#  Apply Actions: in this combo box, the user can select any of SimLab actions to apply to the selected object. Applied actions can be exported to 3D
PDF files, as well as HTML (Web GL).

 
 
SimLab Actions:

 

SimLab Composer supports a number of predefined actions that can be executed upon clicking a 3D model, or clicking Templates’ elements.
Advanced users can write their own script to define new actions. SimLab actions can be executed in 3D PDF, and HTML files.

 

 

Action Effect

URL Links 3D geometry OR Template element with the entered web
address, that will be opened On Click.

Animation Play Stops playing scene’s animation upon clicking 3D geometry OR
Template element.



 

 

Animation Stop Stops playing scene’s animation upon clicking 3D geometry OR
Template element.

Scene State Executes a scene state upon clicking 3D geometry OR Template
element. Scene states can be selected by Name or Index.

Message Box Displays a message box upon clicking 3D geometry OR Template
element. The user needs to enter the Message and its Title.

Script Enables users to write their own script to be executed upon
clicking 3D geometry OR Template element.

Pre-Populate  
Video Action allow to play, pause, seek, toggle and play duration for the video

which created from Make Video function from Visual Effects
menu in the VR Worksbunch 

Load Scene Run another Composer Scene from the computer or online "URL
link for the scene" in the VR Viewer.

Import Model Import the model into the scene during experience the VR
Viewer. 

  
Multi Actions Option:

 
If the Multi Actions option is selected, clicking the Actions List button will open the Multi Actions List dialog. By clicking the ‘+’ button the user can
enter a list of actions of different types. The order of these actions can also be changed using the up and down arrows. These actions will be executed
upon clicking the selected 3D geometry, and they can also be applied in 3D PDF templates.

  
Supported ways of applying the actions list are:

 

# Loop; runs the action's list upon click in order, then from start again. That is action_1, 2,3 …, then 1, 2, 3.
# Swing; runs the action's list upon click in order, then backwards again. That is action_1, 2,3 … then 3, 2, 1.
# Random; runs the action's list upon click randomly.
# Run All; runs the action's list upon click in order one time.
 



 

 

 

  
Scene State:

 Executes a scene state upon clicking 3D geometry OR Template element. Scene states can be selected by Name or Index.

  
Play Sound:

 Utilize and employ sound effects in your exported 3D PDF files; either by assigning them to any 3D object via SimLab Composer or to 2D elements of
your templates via SimLab Template Designer.

  
Play Sequence:



 

 

 Utilize and employ Animation Sequences in your exported 3D PDF files; either by assigning them to any 3D object via SimLab Composer or to 2D
elements of your templates via SimLab Template Designer.

  
 Transform Tab:
 In this tab the location of the selected object and its pivot can be known, as well as changed with precise values. Also Scaling uniform/non-uniform

can be done for the object around its center.

 
 
Both the Object and its pivot have Global, and Local locations/orientations. The Global location is the location of the object’s center relative to the
world’s coordinate system. The Local location changes according to the transforms performed on the object, relative to its parent.

 
 
Attributes Tab:

 
In this tab the user can define attributes attached to the selected geometry in the 3D scene. These attributes can be exported to 3D PDF files, and
when the ‘Export Object Attributes’ option in the Advanced tab of PDF Settings dialog is checked; This can help designers communicate BIM and
metadata.

 
 
Material Tab:

 In this tab the user can change the Name and Type of the material for the selected geometry. SimLab Composer supports different material types.
Common properties between different types of materials are grouped in a common place in the Properties panel.



 

 

 

 

 
Different types of maps can be also applied to the material of the selected geometry, in this tab. These maps can have different effects on the look
of the 3D model, thus reducing the needed modeling time and complexity. Each map has its own parameters that can be accessed by clicking the
downwards arrow under the map’s image file. The user can add a map to a material by clicking the ‘+’ image, a material can also be deleted by
clicking the ‘x’ button under the material image.

 
 
Texture Maps can be applied to any material type. The user can select to apply a texture file, and then fine tune the different parameters to get the
required effect.

  



 

 

Bump Maps are used to simulate the look of geometric details on objects, so it helps the user avoid the inefficiencies when modeling these details in
the geometry itself. Bump maps can be set to a texture of any format. Notice that even when a colored image is supported, it is still utilized as if it is
in gray scale since bump map utilizes the intensity and not the color of the pixels.

 
 
The bump map basically simulates the effect of changing the surface level of the object, where bright pixels in the bump map image simulate
heightened areas, and dark pixels represent lowered areas.

 

 
On top of the regular texture, scale, and offset properties, the bump map has one additional parameter, Strength which can be set to any positive
value, and gives the user the ability to modify the bump effect where higher values make the effect stronger and more pronounced and therefore
cause object to appear less smooth.

 

 
Normal Maps are similar to bump map, used to simulate the look of geometric details on a 3d object. The difference is that in the case of bump map,
a gray scale image maps the height of the surface, whereas in the normal map a colored (RGB) image is used to map the direction of the normal in
addition to its height. As such, a normal map enables finer control, but requires three channels (R,G, and B) to perform normal calculations. 
 

 Normal maps are generally generated by specialized software, which should give an RGB normal map image according to the desired effect by the
user, in addition, lots of usable normal maps can be found on the net.

 
 
Opacity Maps give the user the ability to specify holes, transparent areas, and opaque areas on the mapped object. The image itself contains the
opacity data in the following way:

 
#  Black pixels in the image map represent holes
#  Gray pixels represent semi-transparent areas (as brightness increases, opacity increases)
#  White pixels represent opaque areas

  

 Roughness map allows the user to set an image based distribution of roughness for metal and plastic materials instead of a single value applied to
whole material.

  

Roughness map:



 

 

 

  

Alpha Channel Emitter: Alpha areas of textures will turn transparent if used on an emitter.

https://www.youtube.com/watch?v=NDIpppu8OSU
https://www.youtube.com/watch?v=NDIpppu8OSU


 

 

 

  

https://www.youtube.com/watch?time_continue=26&v=uvS8hl_hq6w
https://www.youtube.com/watch?time_continue=26&v=uvS8hl_hq6w


 

 

Smart Toolbar
  

Smart toolbar is added to the GUI of SimLab Composer to make your work even smoother, faster and easier.

 The Smart Toolbar is small, simple, and powerful. It gives the user quick access to the most frequently used commands. This toolbar is considered as
shortcut launcher. It will enable the user to use functions without the need to switch to Scene Build workbench.

 

 The Smart Toolbar is found compound in the Object tab of the right panel, as shown in the image bellow.
  



 

 

 

  
  

 

It consists of the following buttons:
 

•  Select Objects Using Material: allows you to select object(s) that have same materials.
•  Apply Materials To Selected Object: allows you to apply materials to selected object.
•  Regenerate Material Icon: a button, if clicked, will regenerate new icon/thumbnail images for the content of the corresponding library, for
display purpose only.

 



 

 

Drag-and-Drop
 
  

In SimLab Composer, it is easy to copy a material from one object to another.
Click on the object to show its material in the properties panel, now you can drag the material icon and drop it on the new object to copy material
properties to the new object, as shown in the following image.

  
 

  



 

 

Current Action Area
 

 
This area will display the last captured Scene State, in case of Scene States creation. In case of using any of the draggers in the Move task, a spin box
will be displayed in this area. The user can input values in this box, or use its spin arrows, as shown in the following image.
 

  

 

  



 

 

Camera Snapshot
 

 
Capture Camera Snapshot

  
The Camera Snapshot Button is located at the leftmost on the 3D area, as shown in image bellow

 

 
# Snapshot: This button allows you to capture formal camera snapshot quickly. A snapshot is generally the capture of an object's state at a specific
moment in time.
 

 

  

Don't be confused between Snapshot button and Capture Image button. Snapshot is about preserving informative scene state to be used later,
whereas Capture Image is about generating an image from the viewer as it is in the 3D-Area or a rendered image if rendering process is turned on.
 

To delete a snapshot or a collection of taken snapshots, go to the Scene State Library which you can find under the Scene State tab on the Scene
Building ribbon after switching to the Scene Building workbench.
 



 

 

 



 

 

Messages Area
 

 
Some functions in SimLab Composer require the user to make some kind of action/selection. In this area of the application interface, messages can
be displayed to inform the user about the required action, as shown in the following image.
 

 



 

 

View Cube
 

 
Use the View Cube to orbit your design or view the design from standard view positions. Click on the faces and corners of the cube to access standard
orthographic and isometric views.

  

 



 

 

Composer Workbenches
 

  
SimLab Composer's unique trait is an extendible framework architecture that allows multiple workbenches designed for different purposes to collaborate
and aid the user in achieving his objectives.

  

 The workbenches system isolate particular main functions into separate categories to assist the user in quickly accomplishing his goals, and to eliminate
the confusion caused by having a complicated interface that might hinder the user's ability to access the available tools with ease.

  

 
You can easily switch between workbenches, click on the workbenches Icon at the top left corner and select the workbench suitable for your task. You
can choose the scene building workbench, which holds the basic and primary tools found in SimLab Composer. You can also select the texture baking
workbench. The animation workbench. The simulation workbench. The automation workbench. And finally the virtual reality workbench.

  

 You can choose the scene building workbench, which holds the basic and primary tools found in SimLab Composer.

  
 You can also select the texture baking workbench.
  
 the animation workbench, or the simulation and automation workbenches.
  
  
  
  
  
  
  
  
  
  



 

 

Scene Building Workbench
 

 
SimLab Composer consists of a set of workbenches, Scene Building is the default workbench, when you change the workbench, the user interface
and workspace will change accordingly.

 

 
Scene Building workbench is equipped with all the tools needed to build 3D scenes. Upon selecting this workbench, the workbench task bar will show
the following tasks as shown in the picture below, File Menu, Move Menu, Create Menu, Geometry Menu, Material Menu, UV Menu, Scene States
Menu, Render Menu, Image Effect Menu, Navigator Panel:

  

 

 
  



 

 

  

The refined scene building workbench video:

 

https://www.youtube.com/watch?v=k0klRFKexuw
https://www.youtube.com/watch?v=k0klRFKexuw


 

 

File Menu
 

 
 
In this part of SimLab Composer interface, the user has access to several applications such as, new, open, import, export, settings, register, help and
more.

  
 

 



 

 

Scene Group
 

 
New/Open

  
Upon starting SimLab Composer, or clicking on the new button, the new scene dialog will appear. In this dialog the user can select to create a 2D
ground scene, to open a scene, or to create an empty one. Images of the recent opened scenes are displayed in this dialog for a quick access. The
last files list is also accessible from the arrow beside the open scene icon.
 

 

                                               

SimLab Composer is enclosed with short and brief learning videos.



 

 

 

The Getting Started Movies are essential to let you get started quickly and easily without the need for streaming services over a wired or wireless
network connection to the Internet. They cover the following topics:
 

1.  Introduction to Composer, its GUI, and its workbenches.
2.  A tour within the Scene Building Workbench.
3.  A quick tour on how to use Texture Baking Workbench.
4.  A look at the Animation workbench.
5.  An overview to Simulation Workbench.
6.  A look at the Automation workbench.
7.  A look at the Virtual Reality workbench.

 

 
The user can access any of the provided videos by clicking on Tutorials button, which appears at the top right corner of the New Scene dialog box,
as shown in the following image. Once you click over the Tutorials button, SimLab Composer will launch your default Internet browser and display a
list of movies to be played inside HTML5 technology, with the latest versions of Mozilla Firefox, Google Chrome, Safari, and Opera support.

  

 

  

 The following image shows the home page of the Getting Started Videos, which it can be opened in an Internet browser prompting the user either to
choose the desired movie page from a list or start playing the movie right from the player control buttons.

  



 

 

 

  

The user can access the new scene dialog box every time by clicking the new button from the scene menu located under the File tool.

  

We highly recommend you to always upgrade your Internet browser to have the latest version installed, in order to play and view the movies without
problems.

 Save/Save As
 Both function buttons will open the Save Composer file dialog, where the user can select the name and location for the created *.sim file.

 
 
Pack

 This function button displays "Pack The Scene" dialog, in which the user can create *.zip file based on the selected file format from the list.
  



 

 

 

 
 
The packed *.zip file will include all 3D models in the scene, along with their materials and textures. HDR files and BackPlates can also be included, if
the user checks this option. Packing a scene is necessary for the user to share 3D scenes created in SimLab Composer with others.



 

 

Sharing Group
 

 
Sharing Group

 SimLab Composer can be used as a sharing application. Users can share their 3D models and scenes with others in different methods that preserve
models security.

  



 

 

Import/Export Menu
 

 
Import/Export

 

 
Both function buttons will open the corresponding Import/Export Geometry dialog. The import function enables the user to build scenes filled with
3D models from different file formats. The export function, on the other hand, enables the user to share the created 3D scene with others in different
formats.
Clicking Import will display the Import Geometry dialog, where the user can browse the 3D geometry to import. Upon selecting a 3D file, the Import
File dialog will appear as shown below. In this dialog the user can set different options for 3D import, including; Up vector; Z axis is selected by default.
The user can choose a different access depending on the design of the imported 3D geometry.
Scale and center; this option when checked will scale the imported geometry to fit into the 3D scene. It will also import it to the center of the scene.
 

 

  
  



 

 

 

 

 
Keep dynamic link: This option in SimLab Composer import function improves working with 3D design applications. It enables users to keep dynamic
link/automatic update between the 3D model design application and SimLab Composer, when the ‘Keep dynamic link’ option is checked in the import
dialog.
 
In the images shown below the house designed in Google SketchUp was imported into SimLab Composer, with the dynamic link checked. Different
materials and texture were applied to the house model, in SimLab Composer and real time rendering was started. 
 



 

 

 

 

 
In SketchUp the model has been changed/saved, where the garage area was made bigger. To keep the dynamic link, SimLab Composer issues a
message informing the user about the model’s design change.
 



 

 

 

 

 

 
In this dialog the user can save the model in SimLab Composer with the old design. Then clicking Update, with the Retain scene materials option
checked, will update the design model while keeping SimLab Composer materials and textures.
 

  
Supported import formats

 SimLab Composer supports importing the following industry standards CAD/3D file formats.
 

 

xaml Standard format √
3dxml CATIA √
skp SketchUp (up to ver 2018) √
3dm Rhino (up to ver 6) √



 

 

sldprt, sldasm SolidWorks (up to ver 2016) √ (Windows only)
sat ACIS √ (Windows only)
STEP Standard CAD format √
IGES Standard CAD format √
U3D Standard format √
3D PDF Adobe Acrobat (U3D Based) √
DAE Collada (Standard format) √
FBX (up to ver 2016) √
3DS 3DS √
OBJ Wavefront √
STL Stereolithography √
DWG AutoCAD (Up to 2018) √
DWF/DWFX Autodesk Standard √ (Windows only)
DXF AutoCAD √
OSG Open Scene Graph √
ipt, iam Autodesk Inventor (up

to 2015)
√

X_T, X_P Parasolid √ (Windows only)
IFC IFC √
par, asm, psm Solid Edge (up to ST6) √ (Windows only)
Zim SimLab Archive √
Sim SimLab Composer √
PRC Product Representation Compact  
JT  √

PRC Product Representation Compact  
CTM Compressed Triangle Mesh  

GoZ ZBrush √
Gltf/glb  √

Json  √



 

 

vrpackage SimLab VR Viewer, VR Application  
  

  
Supported export formats

 3D Scenes built using SimLab Composer can be exported in the following file formats.
  

 

Export File Formats
3D PDF (*.pdf)

HTML 5 (*.html) +WEB GL
osg (*.osg)

osgb (*.osgb)
ive (*.ive)
obj (*.obj)

DWF (*.dwf, *.dwfx)
DWG (*.dwg)

DXF (*.dxf)
SketchUp (*.skp)

3DS(*.3ds)
U3D (*.u3d)

KeyShot (*.bip)
Collada (*.dae)

FBX (*.fbx)
DirectX (*.x)
Indigo (*.igs)

STL (*.stl)

CTM (*.ctm)
Composer RT (*.xml)

JT Multi File (*.jt)
JT Single File (*.jt)

.prc



 

 

Simulation (*.json)
SimLab iPad File (*.zim)

SimLab VR Showroom (.vrzim)
SimLab VR Viewer (.vrsim)

.360sim

.360zim
.vrpackage



 

 

3D PDF
 

 
3D PDF

 3D Scenes created in SimLab Composer can be exported into custom designed 3D PDF files, using SimLab Designer. The exported 3D PDF files can
be opened using the free Acrobat reader (version 9.0 or newer), to take advantage of all the features in the generated 3D PDF file.

  
 

 
 
Features exported to 3D PDF files, as well as to HTML/WebGl files are listed in the table below.
 

 Exported Features 3D PDF Files HTML5/WebGL Files
3D models and Geometry √ √
Textures √ √
Materials and Colors √ √
Scene States √ √



 

 

Visualized Scene Options
(Lists)

√ √

Animations √ √
SimLab Actions √ √
2D Polylines and
Annotations

√  

Cameras √ √
Reflection Maps √ √
Bump Maps √ √
Custom Designed
Templates

√ √

In the PDF button, and before attempting to export to 3D PDF, the user needs to choose the PDF Settings for the exported 3D PDF file.

  

In the tutorial video below show you how export your models to 3D PDF and visualize it with others using the free Acrobat Reader.



 

 

 

https://www.youtube.com/watch?v=X7V4XX4D9iI
https://www.youtube.com/watch?v=X7V4XX4D9iI


 

 

Export Button
 

 
PDF Settings

 PDF Settings dialog enables the user to control the look and behavior of the exported 3D PDF file(s). To open PDF Settings dialog, click Settings in
the 3D PDF button menu. The dialog has five tabs, described below.

  
Template Tab

 
Is where the user can select a 3D PDF template, browse to the folder containing the template to use, create New templates, Edit, Delete, or Refresh
template(s). Clicking the New button will open SimLab Template Designer.
 



 

 

 

 

 

 
SimLab Designer is a simple SimLab application that enables users to design and save their own templates, to be used when exporting their 3D
models into 3D PDF or HTML5/Web GL or iPad/Android. For more details about SimLab Designer, select Designer Help from the Settings/Help bar in
SimLab Composer.

  
Page Tab

 
In this tab the user can add background music to the exported 3D PDF file, and a Password for protection, and attachment file . The user can check
the Repeat option, to keep playing the music as long as the PDF file is opened.
 



 

 

 

  
  

 File Attachments: Attach any number of any file format with your 3D PDF files exported from SimLab Composer.



 

 

 PDF Document Fill Mode: Browse and select any 2D PDF or 3D PDF file document and set it as the Fill Mode for your 3D PDF exported
using SimLab Template Designer.

  
3D Tab

 In this tab the user can set the properties of the 3D area in the 3D PDF template.
 

 



 

 

 

 

 

 
•   Show 3D Toolbar: shows or hides the 3D Toolbar in Acrobat reader when opening the exported 3D PDF file.
#  Show World Axes: Shows or hides the world axes, in the lower left part of the exported 3D PDF file.
#  Open Model Tree: Opens the 3D model’s tree in the exported 3D PDF file.
#  Disable Selection: Disables/enables selection of geometries in the exported 3D PDF file.
#  Navigation Mode: The user can set the default navigation mode for the exported 3D PDF file to be Rotate, Spin or Walk. The user of the 3D PDF file
can choose to change this default mode from inside the exported 3D PDF file.



 

 

#  Default Render Mode: Using this option, the user can select the default render mode to be one of the following (Solid, Solid Wireframe,
Transparent, Transparent Wireframe, Illustration, Shaded Illustration, Transparent Bounding Box, Solid Outline, or Bounding Box, Transparent
Bounding Box Outline, Wireframe, Shaded Wireframe, Hidden Wireframe, Vertices, Shaded Vertices).
#  Default Light Type: light type can be one of the following: white, day, night, bright, CAD optimized, cube, or head lamp.
#  Light Power: increasing this value increases the brightness in the exported 3D PDF file.
#  Navigation System: in this group the user can set the navigation mode, in the exported 3D PDF file. The navigation mode can be either Default
Navigation; which tends to focus on one object in the scene, or SimLab Smart Navigation which is suitable for large scenes.
#  Cameras/Scene States: in this group the user can check the Show SimLab Buttons Bar option, and choose an option for navigating different
cameras/scene states in the exported 3D PDF file. SimLab Buttons Bar can be:
   o Artistic Arrows: arrows will be used for navigating between different cameras/scene states.
   o Numbered Buttons: numbered buttons will be displayed to represent each camera/scene states.
      o Preview Images: preview images of the exported scene states will be displayed to represent each camera/scene states. (Available only in
SimLab Composer)
#  Automatic Transition: this option enables automatic switching between, the different cameras in the scene. When automatic camera is enabled, the
user can select the Pause Duration, which is the time in seconds for which the camera will stand still before camera effect starts.
#  Animate Camera Transition is an option for animating the transition between different cameras in the scene. The Duration (seconds) is the time of
the animated transition. In case of no animated transition.
Time before switching cameras = Pause Duration + Duration (seconds)
The user can select the camera effect to be Zoom, Roll or the two combined. The camera effect will take place for the camera effect duration.
In case the Automatic Camera option is not checked, the 3D PDF file will be exported with the scene cameras, but will not automatically switch
between them.
The Preview Image group is available for the user to choose to include or not to include a preview image for the exported 3D PDF file. In case
of selecting an image, it will be displayed when browsing for 3D PDF files, to help the user in selecting the required file. This image will also be
displayed when the user first opens the 3D PDF file. The image can be a rendered view image of the model/scene.

  
 Animation Tab
 In this tab SimLab Composer users can set the properties of the animation(s) in the exported SimLab 3D scene.

 

•   Frames per second (FPS): is the number of frames played per second for all animations created in the exported 3D SimLab scene. This controls the
speed of playing all the animations in the scene, a value of 5 will result in a slower motion animation than a value of 15.
#  Playing Mode: is the mode to use when the animation(s) reaches an end. The Repeat option will keep on repeating the animation(s), from
beginning to end, as long as the PDF file is open.

 
 
Swing option will keep on playing the animation(s), from beginning to end then from end to beginning, as long as the PDF file is open. The Play Once
option will play the animation(s) only once.



 

 

 

 

  
Advanced Tab

 
#   Document Java Script and 3D Java Script: Can be used by advanced users to insert Java scripts to control both, the PDF document, and the
included 3D model. Java scripts can be applied to designed templates, to make specific actions. Details about Java script support in 3D PDF files can
be found at: http://www.adobe.com/devnet/acrobat/javascript.html.

  



 

 

 

 

 

 
#   Make Protected / Disable Measurement: This option is available for users to protect their exported 3D models, as it will prevent measurements of
the model in the exported 3D PDF file.
#   Preserve Images Original Resolution: If the PDF template includes an image, this option when checked will preserve the image’s original resolution,
and will increase the file size.
#   Full Screen: Check box; if checked will make the 3D PDF file start in Full screen mode.
#   Export Measurement and Text Annotations: Checkbox; when checked will enable exporting measurements and text annotations in a 3D scene to
3D PDF.
#   Export Polylines: When checked, 2D polylines in the scene will be exported.



 

 

#   Export Object Attributes: Object attributes defined in the Properties dialog, for any object, can be exported into 3D PDF files by checking this
option. This can help designers communicate data with files’ recipients.
#   Open file after export check box: Will open the exported 3D PDF file.

 
 
3D PDF Export

 

 
After setting the different properties/settings for the 3D PDF file, clicking Export will open the Export Geometry window. The user can browse to the
location to export the file to, and can input the file name.
After clicking the Save button, for 3D scenes with Scene States, the Manage Scene States dialog will appear. This dialog allows the user to check the
scene states to include in the generated 3D PDF file, and the order of the scene states in the file, by using the up and down arrows.

 For scenes with no Scene States, and which include multiple cameras the Cameras Manager dialog will appear. This dialog allows the user to order,
rename, and select cameras to be included in the generated 3D PDF file.

 
 
Export with Android/iPad support

  

 
In SimLab Composer GUI, the Export Toolbar was expanded to have the Android/iPad button. This option extends the sharing capability of SimLab
Composer by allowing the user to export a single 3-D PDF file which is supported and readable by multiple platforms using Acrobat Reader (PC and
Mac) or SimLab CAD Viewer (Android and iOS devices).

  
 The images bellow show the same model using different render modes:
  



 

 

 

    



 

 

Tools Buttons
 

 
3D PDF Merge

 

This option enables users to merge two or more PDF files together. This can be used to append a 3D model to a company’s header, or a project
description available in PDF format. PDF files can be generated using different programs, such as; Acrobat, WinWord, PowerPoint, or Open Office. Different
3D PDF files generated using SimLab products can also be merged together.
Upon selecting this option the Merge PDFs window will open. In the Merge PDF Window the user can click ‘+’ to add the PDF files to merege. Clicking will
remove the selected file from the list, and the up and down arrows changes the order the files to be merged in.

  

 

 
  
 3D PDF Embed

 

3D PDF template files can be embedded into WebGL/HTML. Clicking this function button will open the Embed PDF inside Html dialog. In this dialog the
user can choose the PDF file to embed, or create a new file. The Embed Fonts In HTML check box will include the template fonts in the exported PDF file.
After setting all parameters, clicking Export will open the Export dialog. The user can input the file name, and choose its location, and then click Save.
 

 

  



 

 

WebGL
 

 
WebGL

 

HTML templates design is fully supported with advanced 2D layout. Behavior Actions can be exported into HTML5/Web GL, enabling users to create
interactive 3D experience on the web. Reflection maps, sun light and shadow are applied to 3D models and exported to HTML, giving them more
realistic look with smother camera navigation and better appearance for materials. 3D scenes can be exported into html5 files, the same way 3D PDF
files are exported.

  
 

 

 
In the WebGL task bar in the Sharing workbench, click Settings to open Html5 Settings window. In settings window the user can select the template
to use, and choose the other html export settings. With a template selected, click the Export button, then enter the name and location of the (*.html)
file and click Save.
 



 

 

 

 

 
 
For 3D scenes with scene states defined the Manage Scene States dialog will appear upon clicking Save. There the user can check the scene states to
include in the exported html file, and their order.

  

Export billboard objects, created in SimLab Composer, to 3D-PDF and WebGL (Web/HTML).



 

 

 

https://www.youtube.com/watch?time_continue=33&v=OEYlebD8N3s
https://www.youtube.com/watch?time_continue=33&v=OEYlebD8N3s


 

 

Export Toolbar
 

 
HTML5 Settings

 
HTML5 Settings dialog enables the user to control the generated HTML file(s). Before exporting to HTML, the user needs to select a template to use for
export, and to set other HTML parameters.
 

 Template Tab

 

Template tab is where the user can browse the folder containing the HTML template(s) to use, and create New templates, Edit, Delete, or Refresh
template(s).
 
Clicking the New button will open SimLab Designer window. SimLab Designer is a simple application that enables users to design and save their own
templates. For more details about SimLab Designer, select Designer Help from the Settings/Help bar in SimLab Composer.
 
Embed Fonts In HTML option, when checked, will include the font used in the template, in case of using distributable fonts.

  



 

 

 

 
  

  
3D Tab

 In this tab the user can set the properties for the 3D Area. The ‘Keep Camera Above Ground’ option, allows architects to prevent viewers of their 3D
models from viewing under the buildings, also user can enable/desable the Shadow from the sun, the reflection and the Sun Environment.



 

 

The user can also select the navigation mode in the exported HTML file. Spin navigation mode adds great navigation experience.
  

 

 
  



 

 

 #  Navigation Mode: The user can set the default navigation mode for the exported 3D PDF file to be Rotate, Spin or Walk. The user of the 3D PDF file
can choose to change this default mode from inside the exported 3D PDF file.

  
Animation Tab

 In this tab SimLab Composer users can set the properties of the animation(s) in the exported SimLab 3D scene.
 

 

•  Frames per Second (FPS): is the number of frames played per second for all animations created in the exported 3D SimLab scene. This controls the
speed of playing all the animations in the scene, a value of 5 will result in a slower motion animation than a value of 15.
 
•  Playing Mode: is the mode to use when the animation(s) reaches an end. The Repeat option will keep on repeating the animation(s), from beginning to
end, as long as the PDF file is open.
 

 Swing option will keep on playing the animation(s), from beginning to end then from end to beginning, as long as the PDF file is open. The Play Once
option will play the animation(s) only once.

  



 

 

 

 

  
Advanced Tab

 
Document Javascript and 3D Javascript can be used by advanced users to insert Java scripts to control both, the HTML document, and the included 3D
model.
 



 

 

Java scripts can be applied to designed templates, to make specific actions. Details about Javascript support in WebGL can be found at the scripting help
in SimLab Composer.
 

 

 

  



 

 

 Message Box Tab

 In the new WebGL exporter, user can make a message box in the HTML by select Message Box from Action into Properties Panel for any
objects in the scene, write the message and the title of the message there.

 

  

 In the message box tab, user can select the style of message box which display in HTML file.



 

 

 

  

 
There are four styles at the moment:

Style Name Style



 

 

Style1

Style2

Style3

Style4

 
 
 
 
 
 
 
 
 
 
 



 

 



 

 

Android/iPad
 

 
Android/iPad

 
3D Scenes created in SimLab Composer can be exported into iPad/Android. The exported scenes will be saved in SimLab Archive File format (*.zim),
readable by SimLab CAD viewer. SimLab CAD Viewer can be installed from Apple iTunes and Google play.
Information exported to iPad/Android includes: geometries, normals, materials, textures, cameras, animation, scene states, and SimLab templates.

  
Templates for iPad/Android viewers

 Templates created for SimLab iPad/Android viewers should be created as follows:
 

 From Android/iPad Settings dialog, click New to open SimLab template designer. The Page Size dialog will appear, create a page with an aspect ratio
close to the aspect ratio of the device you are exporting to (aspect ratio is width to height percentage). For iPad the aspect ratio is 4:3, so a page with
1000 pixels width and 750 pixels height will be ok.
 

 

 

 

#   Add a 3D area that covers the whole template page. In the properties dialog on the left, the user can select the Background Fill Mode for the 3D
area to be:
o Transparent
o Single Color
o Image

http://simlab-soft.com/technologies/simlab-mobile-viewer.aspx


 

 

 

 

 

 
#   On top of the 3D area add images/text, and link them to messages, URLs, or scene states.
#   Add images for different products, and different materials along with links to their scene states created in SimLab Composer. Other actions can be
added to an image, as described in SimLab Actions section.
 



 

 

 

        

You can download android and ios for our VR/AR app here
 

https://play.google.com/store/apps/details?id=com.Simlab.SimlabViewer


 

 

Export Toolbar
 

 
iPad /Android Settings

 iPad /Android settings dialog consists of four tabs:

  
Template Tab

 

Template tab is where the user can browse the folder containing the HTML template(s) to use, and create New templates, Edit, Delete, or Refresh
template(s).
 
Clicking the New button will open SimLab Designer window. SimLab Designer is a simple application that enables users to design and save their own
templates. For more details about SimLab Designer, select Designer Help from the Settings/Help bar in SimLab Composer.
 

 

 

  
3D Tab

 

In this tab the user can set the properties of the 3D Area in the template.
 
The ‘Keep Camera above Ground’ option allows architects to prevent viewers of their 3D models from viewing under the buildings.
 
The user can also select the navigation mode in the exported (*.zim) file.



 

 

 
Tip The Spin navigation mode adds great navigation experience.
 

 In the Light Power spin box, the user can increase/decrease the light power in the generated template and thus in the exported (*.zim) file.

 

 

  
Animation Tab

 For scenes that include animation, checking the Show Time Line option will display the time line on top of the template.
 



 

 

 

                     

  
Advanced Tab

 

In this tab, and by checking the Make Protected option, the exported (*.zim) file will only be viewable using SimLab CAD Viewer. The file will not be
readable by SimLab Composer, and thus the 3D models included in the file are protected.
 
The Export Polylines option, when checked, enables exporting polylines included in the 3D scene.
 
Checking the option Include Dictionary will make the current values set in the dictionary to be saved in the generated zim file.
 



 

 

 

 



 

 

Cloud Group
 

 
Retrieve

 This function button will open the Onshape's cloud. It's a way to import CAD data in SimLab Composer. Onshape is integrated with SimLab
Composer, that means cloud-based documents can be imported to SimLab Composer right from Onshape's cloud storage.
 
Using SimLab Composer along side with Onshape is made easy, since most CAD file formats can ride in.
 
With Onshape, CAD data is kept available anytime and accessible from anywhere. Also the user can get the models directly on Onshape clouds.
 

 

  

The user can get your models directly on Onshape clouds!

 

As you see in the image below, from this window you can navigate the files on the cloud server, it is similar to the interface of the
Onshape cloud system. You can access your documents, the files you created, your shared files, and also the public server.
Once you select a folder from the list, the contents of this folder will be displayed in the documents list. Then select a document to
display all the elements included in that document. After that select an element and Click import to access the selected design from the
OnShape cloud server through SimLab Composer.
 



 

 

 

  
 Publish

 

 
This function button will open the Sketchfab's cloud. Sketchfab allows you to store your models on a cloud server, and allows you to view
them and share them online.
 
To create one, please Press on Sketchfab button and create an account.
 

 

  



 

 

The user can upload the models directly on Sketchfab clouds!

 
SimLab Composer will start preparing your scene to be uploaded, once the process is completed, a message will appear notifying you that the
preparation is done, and that your model is being uploaded (as you see in the image below).
 

 

 
 
Once the uploading is completed you will get a message with a link to the uploaded model, the message will also ask you whether you need to copy
this link to the clipboard in order to be able to use it by pasting in a web browser. (as you see in the image below).

  

 



 

 

Settings Group
 

 
SimLab Composer interface is based on selecting the workbench to work on first. From the file workbench icon you can find Preferences, and
Register.

  
Preferences:

 The user can change settings in each created scene separately. In other cases it would be easier to set the common settings to be used when creating
new scenes. This can be done in the Preferences dialog. This dialog has five tabs, described below:

  
This can be done in the Preferences dialog. This dialog has five tabs, described below;

  
Directories Tab

 In this tab the user can change the default directory(s) for Textures, Material libraries, Object libraries, and Templates used for exporting to 3D PDF,
HTML/Web GL, and iPad/Android.

 Advanced users may select to move the User Data directory to a new location; the user should copy the original data to the new location before
setting the new User Data folder.

  



 

 

 

  
Camera Tab

 
Keep above Ground; if checked the camera rotation will stop at the ground level, and won’t go below. This option is applicable to Parallel and
Perspective cameras.
 

 Background Color; is the color of the scene’s background in SimLab Composer. To display the selected background color, check Preview Background
in the Background Settings, under the Render menu, and uncheck the Preview Environment.

  



 

 

 

  

To set a Background Image for the 3D Area, that is invisible during rendering:
Go to Setting/Help bar » Preferences » On the Preferences dialog box » Camera tab » Background section » Select Image combo box » Browse to
select an image.

  
Import/Export Tab



 

 

 
Automatically transform imported models; when checked, the first imported model will be automatically transformed/scaled by the value entered
in the ‘First model size to world size’ text box, to the largest dimension of the world size of that scene. The model will be placed in the center of the
world.

 The same transform/scale will be applied to all imported models in that scene.

 

 

 
 
# Polylines Geometry: in this group the user can select to import measurement and text annotations created in the design CAD package. Importing
polylines can also be checked, and the width of the imported lines can be specified. In the image shown to the right, the same model was imported



 

 

twice, with import measurements and polylines options checked. The first time Line Width was set to 1.5, and then to 5.0 in the second. As can be
seen in the image the trees branches are wider in the second time.
# Export Units: are units to be used when exporting 3D models from SimLab Composer. By default SimLab Composer uses meter units, and the user
has the option to select different units. All numbers will be converted to the selected unit to maintain the correct size of the exported object.
# Automatically generate texture coordinates; texture coordinates for the imported geometry will be automatically generated when this option is
checked.
# Scale preview image of textures.

  
Appearance Tab



 

 

 

 

  
In this tab the user can set the preferred appearance options for SimLab Composer, including:

 Language: this option allows the user to select the language to be used in SimLab Composer from the supported languages combo box. Changing
the language takes effect after restarting SimLab Composer.

 Tree Transparency: this option allows the user to change the transparency for the background color for the objects Tree.

 Picking: this option allow the user easy to picking the arrows for rotate, scale and transform the objects, for example if the user set it equal 1 then
need to select exact the arrow for the transform, but if the user set it equal 10 then can picking the transform arrow even when the user click near it.



 

 

 Style Group: enables the user to select between two available styles, for SimLab Composer’s interface. Changing the interface will take effect after
restarting the application.

 Fixed View Group: if the view mode in the Common toolbar is set to Fixed Size, the values for the Width/Height entered in this group will determine
the size of the 3D area.

 

Preview Images group: these preview images are the ones used in the Basic tree. Thus if the Generate preview images option is unchecked, no
images will be generated. A basic 3D Geom image will be displayed instead. If it is checked the user can set Max generation time, which is the max
time in seconds spent in generating preview images for the selected geometry, all the way up to its top assembly. The cashing for these generated
images will be kept, thus if the maximum generation time was not enough to generate all images the first time the geometry was selected, they can
be generated the next time.

  
Renderer Tab

 This tab will appears only, if your computer support new renderer.



 

 

 

 
 
Register

 
Clicking this option will display the License Dialog, where the user can manage the Composer license. The user can buy professional licenses, or get
free trials. For more information about requesting/activating a license go to : http://www.simlab-soft.com/simlab-composer-license-step-by-
step.aspx

  



 

 

 

 



 

 

Help Group
 

 
Help

 Under the Help menu the user has access to different help documents, including;

 

 
•  Composer help document.
•  SimLab RT Renderer help document.
•  SimLab Designer help document.
•  SimLab Scripting help document.
 

 

 Tutorial
 You can access the online tutorial page on our website for more tutorials.

http://simlab-soft.com/3d-products/simlab-composer-tutorials.aspx


 

 

Move Menu
 

 
In this menu all functions necessary for positioning geometry in a 3D scene can be found.
 

 



 

 

Transform Group
  

Transform
 When the user clicks any dragger in this tool task, a small scroll combo box will appear, at the current action area, at the top right corner of the 3D area.

The user can use this box to input exact numbers for translation/rotation/scale or can just scroll up and down. If the user prefers to freely drag the 3D
geometry, this can be done using the dragger in the 3D area. Different draggers are described in the table below.
 

 

 



 

 

Snap Group
 

 
Snap

 The snap functions are used for aligning 3D objects.
 

 

 

 
#  Snap to Ground: snaps the selected object(s) to the ground.
#  Snap To Object: snaps the selected object(s) to a target object.
#  Align: Align selected object(s) along a user defined axis, can be used in conjunction with SimLab composer picking modes.
#  Dynamic Snap: it's a smart tool that aids the user in placing objects in accordance with its surroundings. When activated, a blue box will envelope
the selected object which in turn will snap and collide with nearby object giving the user a guide on how to place the object without penetrating other
objects in the scene.
 
 
 

  



 

 

Pivot Group
  

Pivot
 The pivot of a 3D geometry is the point which transformations applied to that geometry will be done.

 
 

 

 
# Show Pivot: When toggled on, this function will display the selected geometry's pivot point and grant control over its location and rotation.
# Move Pivot: This function allows the user to snap the pivot point to another point location. The user can make use of the Pick Mode options
described in the Common Toolbar, to help in selecting the point's location accurately.
# Snap Pivot: This function requires the user to select two points, and the pivot of the 3D geometry will be snapped to the center between them. the
user can make use of the Pick Mode options described in the Common Toolbar, to help in selecting points accurately.
# Reset Pivot: This function restores a modified pivot location to the center of the selected geometry.

  



 

 

Create Menu
 

 
This menu provides the user with the ability to create different scene elements that can add value to the 3D scenes.
 

 



 

 

Light Group
 

 
Light

 
This function has the supported light types in SimLab Composer, which are suitable for interior scenes. Users can add any of these light sources
in addition to the light sources included in the environment image. Light sources in SimLab Composer - except for the Camera Head Light- are
exported to 3D PDF and HTML.

  

 

   
  

 Point Light

 

Selecting this light type will create a spherical Light Source geometry and add it to the scene. Point lights can be moved and positioned, using any of
the move draggers. In the image below three point lights were added to the scene, and were snapped to the side lamps’ geometries using the Snap
To Object tool in the Object task bar. Fine positioning was also done using the Move 3D tool.
The light properties can be found in the Properties panel, to the right of the 3D area. There the user can edit a light’s properties, like changing its
color, or its power.
 



 

 

 

 
 
Area Light

 
Depending on the effect the user needs, this is another light type that can be used. As shown in the image below the same scene is now lit using an
area light.
Same lik Point lights, area lights have parameters that the user can change in the Properties panel.

 
 
Spot Light

 Spot Light is another light type that can be created in SimLab Composer. In addition to the main light properties, spot lights have Cone Angle
property that sets the angle of the light.



 

 

 

 
 
Directional Light

 Directional lights are for exterior scenes. The user can change the direction of the light but not its location. Other parameters for this light include,
light Color, light Power, and light Name.

 
 
IES Light

 

 
3D interior and home design just reached a whole new level thanks to this new light category. Now, SimLab Composer supports IES data, an
important factor for architecture visualization. Using IES light in your interior scenes can appear and produce more photo-realistic scenes, as actual
lighting effects are more realistically emulated. The IES Light Library in SimLab Composer (as shown in the following image) contains a collection of
29 pre-installed IES lights and all of them can help you generate a nice ambience lit interior environment for your renders.

  



 

 

If you have already purchased the corresponding license, you can find the IES light toolkit in the Scene Building workbench in the Light tab.
 

The IES Light toolkit includes the IES button, the IES Light Library, and the IES Light Properties Panes which appears at the right-side of the
application window if an IES Light is selected in the scene.

  
 The toolbar of the IES Light Library is located vertically at its left-side, presenting the following three buttons:

 

 

 

 
#  Add New Item: The Add New Item button allows the user to add new IES Light selected from the scene to any activated light tab within the IES
Light Library. When this button is clicked, the Add New Item dialog box appears.
#  Delete Item: This command discards the selected light thumbnail from the panel of the activated tab.
#  Manage Library: The Manage Library button launches the Manage Library dialog box to give the user options to create, delete and rename light
groups which are presented by tabs in the IES Light Library.
 

IES light files are created by many major lighting manufacturers and can be downloaded freely from their sites. One of such lighting manufacturer is
Lithonia Lighting (www.lithonia.com) which has an extensive library of IES files in different categories.
 



 

 

Lighting is perhaps the most important aspect of CG. It really makes or breaks a scene. Once your lighting is ready, you render the scene.

 
 

Portal
 

Portal rendering is an optimization technique in SimLab Composer to avoid unnecessary calculations as possible. This is an advanced
feature used to link two divided adjacent zones (indoor and outdoor) through opening objects. These openings are referred to as
portals. Portals are best suited for indoor scenes, such as windows, doors, and tunnels.

  

For example, you are trying to simulate a sunny day, and beyond the direct light coming through the window, it's pretty dark. This feature will be
a good tool to use in this situation by converting the window or part of it into portal, it gives you an efficient way of using a scene's existing sky
lighting within interior scenes that do not require very long render times. A portal acts just like a mental ray area light. This light gets its brightness
and color from the environment already in your scene.

 
 
New Portal

 New Portal: This button is used to create a portal from scratch.

 
 
To Portal

 This button is used to convert a selected object's face to portal.
  

To distinguish if an object is portal or not, a Portal Icon appears on the Object Tab of the Properties Panel on the right side of the application when
the object is selected.
 

The New Portal tool only allows you to create portals in the form of square, whereas the To Portal tool allows you to create portals from any kind of
shapes.



 

 



 

 

Shapes Group
 

 
Shapes

 The Shape toolbar is provided to give you more control over creating particular basic shapes . This is applicable for Plane, Boxes, Spheres, and
Cylinders.

  

 

The Shape toolbar (as shown in the following image) contains three buttons:
 

•  Plane: a button that allows users to create a Plane by entering Center coordinates, Width, Depth, and Height of the box parameters in its
dialog box which appears if clicked. The below Figure shows the Create Basic Shape dialog box for Plane.

 

 
•  Box: a button that allows users to create a box by entering Center coordinates, Width, Depth, and Height of the box parameters in its dialog
box which appears if clicked. The below Figure shows the Create Basic Shape dialog box for Box.
 



 

 

 
•  Sphere: a button that allows users to create a sphere by entering Center coordinates and Radius of the sphere parameters in its dialog box
which appears if clicked. As shown in the following image, the Create Basic Shape dialog box for Sphere.
 

 
•  Cylinder: a button that allows users to create a Cylinder by entering Center coordinates, Radius, and Height of the cylinder parameters in its
dialog box which appears if clicked. As shown in the following image, the Create Basic Shape dialog box for Cylinder.
 



 

 

 
Click OK to confirm object creation upon entered parameters.

  

 

  



 

 

Paths Group
 

 
Paths

 

Different paths can be created in the Path group. The user can create Open, Closed, or Circular paths. To activate a path, the
user can select it from
the Object Tree. Paths can be used to create Path Animation. Upon clicking any path function, a message will appear in the
Message area, asking the
user to start picking the path points. Approve and decline icons will appear at the top left corner of the 3D area to end
selection.

  

 

  
  
 The user can create paths as points in 3D or on plane.



 

 

 

  

The paths toolbar (as shown in the first image above) contains four buttons:

 

•  Composite
To create composite path, follow the steps below:
1. Click Create → Paths → Composite, When you click on it, the Path Creation dialog will appear.
 
2. In this dialog there are two methods to pick points: in 3D or On Plane, select on plane then click OK.



 

 

 
 3. In the message below, you can create paths by three ways: Line Segment, B-Spline or ARC Line, select B-
Spline.

 
 4. Now, Start drawing the path on the plane, click on any position in plane to put the start point, then put the
second point etc.
When you finish, click OK.



 

 

 
 5. To edit the path, select any point on path then move it.

  

 •  Circular: when clicked, the Composer ask you to select the position for center point of the circle. Then select the position of
the point on circumference (Radius) for the circle.



 

 

 
•  Apply Tangents:  when clicked it will ask you to select a hard point that belongs to the 3D object. A tangent is a straight line
that touches a curved
 surface at a point, but if extended does not cross it at that point.
•  Generate From 2D: create a 2d path from the outside edges of the 3d objects.

  



 

 

Feature Group
 

 
Feature

 In this function we are going to talk about SimLab Composer's features that would allow you to perform basic modifications and improvements to
your 3D models in order to improve the realism of your design's appearance without needing to revert to a CAD application.

  

 

  
Sweep tool

 

After finishing draw the path creation process. Set the rotation for the sweep profile then click on the green mark to create the

sweep .



 

 

  

To create Sweep, Follow the steps below:

 

1. Open the SimLab Composer
2. To create Sweep, you must create two Paths first, one's for sweeping along on it, and the second for a profile of the sweep.
3. Click Create → Feature → Sweep.
4. When you click Sweep, the message will appear in message dialog, select path which you want to sweeping along on it, then click OK.
5. Now select the second path to set it as profile of the sweep then click OK.
6. Finally rotate the profile path in demand then click OK.

  
Extrude tool

 

In the extrude window you can enter the height of the extrude.

  

  
Wire tool

 In the wire creation window you can select the type of wire you are about to create based on the shape of its section.



 

 

You can choose from a circular shape, a rectangle, or a fillet rectangle.

  
  

Creating wires:

 

  

  

https://www.youtube.com/watch?v=edGyNUfkI7k
https://www.youtube.com/watch?v=edGyNUfkI7k


 

 

Street tool

 Simlab Composer's street creation feature is a friendly tool that expands your designing capabilities and allows you to reach high potentials with your
architectural Model effortlessly and efficiently.

 

  

To create 3D Street using SimLab Composer, Follow the steps below:

 

1. Open the SimLab Composer, you can start the program by double-clicking its desktop shortcut or from the start menu.
 
2. To create 3D Street, you must create a Path first.
 
3.Select the path which we have created, then click Create → Feature → Street, the Street Creation dialog will appear.



 

 

 
 4. In this dialog you can find different type for street: a Flat Shape, an Elevated, or an Elevated With Pavement.



 

 

 
5. Also you can set the textures for street and pavement once you click on (+) in the textures side in the window, when you finish, click Create.



 

 

 6. Now the street creation will appear as a new object in Objects Tree
 
 



 

 

Annotations Group
 

 
Annotations

 In this function we are going to talk about adding annotations and measurements to your design in Simlab Composer, and how you can
manage the measurements to create a professional presentation that facilitates communicating and sharing your design.

  

 In this dialogue we are going to determine the plane on which we are going to create the annotations.
Selecting the proper plane for the annotations creation is crucial in terms of where the annotations will be projected for viewing.

  

 

You also have the option to offset the plane you have selected parallel to its axes.

 Create Annotation
 



 

 

 

  

 

SimLab Composer allows you to create several types of annotations.
•  Linear dimension tool, measures the projected distance between 2 points on the principal axes while the aligned dimension tool measures
the distance between two points in space without projecting their location on a principal axes.
•  Radial dimension tool, a button that allows users to create a box by entering Center coordinates, Width, Depth, and Height of the box
parameters in its dialog box which appears if clicked.
•  Angular dimension tool, can measure the angle between two intersecting lines.
•  Leader annotation tool, allows you to add custom text with a pointer to the design.

 

Notice that the linear tool measured the projected width of the two points and not the distance between them.

 
You can change the measurement unit used from the annotation dialogue box, select a measurement unit that is suitable for your design
 



 

 

 



 

 

Bounding Box Group
 

 
Bounding Box

 Bounding box is a tool that creates a ghost box for a single object or a group of objects, the ghost box can then be used in the boolean
operations to modify the geometry of an object.

 

To create a Bounding Box, select an object or group of objects first, then click Create → Bounding Box, the Bounding Box will appear as new object
in Object Tree.



 

 

Camera Group
 

 
Camera

 This menu includes all the necessary functions for creating, and setting the different cameras in a 3D scene also user can apply the camera by double click.
  
 



 

 

Billboard Group
 
 

 
Billboard

 The Billboard lets you create geometry that is camera-aligned. The objects always align to view default or connected camera. The plane geometry
linked to the Billboard will rotate around the local Z axis to face the viewer. The Billboard is centered on the object (plane) which is linked to it.

  

 

To create a Billboard:
 

1.  Go To create tool »Click the Billboard button on it.
2.  Enter settings as desired in the corresponding fields of the Create Billboard dialog box.
3.  Click OK

 
After positioning a tree, for example, it will render as a well-behaved Billboard.

  

 

The Create Billboard dialog box (as shown in the following image) requires the following data:
 

•  Position: Click anywhere in the 3D Area to pick a position (X Y Z) to place the billboard at.
•  Image: Browse and select an image (choose PNG image format to preserve transparency). The default image will be a tree if the user
didn't select an image.
•  Height: Enter the suitable height that you wish in meters. Because it depends and takes the aspect ratio of the selected image, the width of
the Billboard will be approximated automatically.
•  OK: Confirm and accept billboard's settings.
•  Cancel: To exit Billboard creation mode.

 

 

 
  



 

 

Not selecting an image results to tree image.

Billboards are always kept aligned with the camera.

 

 New billboard object was introduced. The billboard object always faces the camera, to allow architects to add PNG trees and humans to the scene,
as shown in the following render.

  



 

 

 

 
  



 

 

Decal Group
 

 
Decal

 Applying a company Logo, or product images to 3D models is made easier with create Decal. Clicking this function will open the Decal window. The
parameters in this window are;
•  Image: requires setting a valid path for a valid image file.
•  Rotation: is the rotation angle, in degrees, to be applied to the decal image.
•  Scale: is a uniform scale value to be applied to the decal image.
•  Depth Factor: is the depth value for applying another image of the decal, in case of applying the decal on more than one geometry.

  
After selecting an image, the user needs to pick four points, and a center to set the image location.

  
To learn more about decal creation, check SimLab Composer tutorials at: https://www.youtube.com/watch?v=7U8Dh6H9K-Y.
 



 

 

 



 

 

3D Text Group
 

 
3D Text

 

Clicking this function will open Create Text3D dialog, where a user can type in text, and select its format. Clicking the OK button will create 3D text
parallel to the ground in the 3D scene. An assembly with geometry for all letters in the text will be added to the Object Tree. Different transforms can
be applied to the text. A user can also change the material of the generated 3D Text, by dragging material form the materials library, and dropping it
on its geometry in the Object Tree.
 

 

           

 
 
To modify anything in the created 3D text, select the text in the 3D area, or in the Object Tree, to display its properties in the Properties Panel.
 



 

 

 



 

 

Section Plane Group
 

 
Section Plane
 

 

Newly created section plane will be selected in the 3D area with the 3D dragger to enable the user to transform/rotate the section plane.
Section plane effects are exported to the generated 3D PDF files, rendered images, and exported file formats such as OBJ.
By default a section plane cuts through the whole scene. Using the Break Using Sction Plane tool, the user can select the geometry to cut using section
plane(s).
In the image shown below a scene with three spheres inside each other and three section planes were created with different orietaions. Select each
section plane and use it to cut through the outside and the middle shperes. To do that go to Geometry task and with the sphere to cut being selected,
click the Break by Plane function button. This will break the geometry into two in the object tree and the 3D area.

  
 Repeating this for all three section planes will split each sphere into eight parts. Deleting / hiding some of the parts will result in the shown image.
  

 



 

 

Geometry Menu
 

 
This menu provides the user with geometry related tools.
 

 

  



 

 

Break Group
 

 
Break Geometry

 The smallest representation of geometry in SimLab Composer is 3D Geometry. 3D Geom is a geometry that has one transform and one material applied to
it. All contents of 3D Geom are moved together, and must have the same material.
Some model formats do not support saving Object Tree structure, when importing 3D models of those formats, 3D Geom can contain many none
connected parts. The Break geometry tool enables the user to break a 3D Geom that contains none connected parts into multiple 3D Geoms. Each one of
the new 3D Geoms can be moved separately and can be assigned a unique material.

 
 
Break Faces

 
This tool will break the selected 3D model into its faces. Each face will be converted to 3D Geom, and added to the Object Tree. Unique materials can
be assigned to each face. In the above stool example, the top geometry with a different material was broken into its faces as shown in the image below.
Different materials were applied to the different generated faces.

 
 
Break by Plane

 This tool enables the user to select the geometry to cut through using a section plane already created in the scene, using Create Section Plane from the
Create task bar. Using the same section plane with different orientations, different cuts can be done on the geometry.

 
 
Break Instances

 Instances in SimLab Composer are multiple duplicates of an object using the same materials’ structure, and same transforms as the original object. Using
this function the instances can be broken, thus each one can have its own materials/transforms.



 

 

Explode Group
 

 
Explode/unexploded

 

Explode function makes it easy to show the components of an assembly. When selected the explode geometry dragger will appear, allowing the user
to explode the selected object(s) in the X, Y, and Z directions. The user can also rotate the dragger to select an arbitrary vector to be used for
exploding the assembly.
 

 

  

Exploding Geometry:



 

 

 

  

 

The user should click either the Approve or the Decline mark in In the central part of 3d area, when done with exploding the geometry. Clicking the
red
Decline mark will cancel the operation of creating the exploded view. After completing the explode operation the user can go back to the original
model by clicking UnExplode.

https://www.youtube.com/watch?v=rZNMtariggs
https://www.youtube.com/watch?v=rZNMtariggs


 

 

Tools Group
 

 
Merge on Material

 
With an assembly selected in a 3D scene, selecting this tool will merge geometry using the same material into a single geometry. In the image shown to the
left, the three selected geometry in the car model are using the same material. In the right image the Merge.
 

 Smooth Normals
 this tool can be used to average the normals of the geometry to appear smoother during rendering

 

 Flip Normals
 Clicking this tool will  have thw selected objects normals flipped.

 
 
Combine Vertices

 Vertices having the position and normal direction will be replaced by a single vertex, using this tool. This will reduce the size and complexity of a 3D model.

 
 
Info

 Clicking this tool will display Geometrical Info dialog, showing the number of Objects, Vertices, and Polygons in the selected geometry. Knowing the
number of vertexes and polygons can help a user estimate the size of the output file. This might make the user ignore some details, for sharing efficiency.

  



 

 

Voxel Group
 

 
Voxelize Task

 

Voxlizing a 3D model is rebuilding the 3D model using building bolcks (voxels), like LEGO. The user can choose the building block to use for
voxelization,
and can choose to voxilize the whole scene, or the selected geometry. Notice that this will add a significant number of polygons to your 3D scene.
 
The Voxelize Options dialog will appear, when clicking any of the voxelization options. The default voxel object is a cube of certain size, and
the user can choose a different object, by clicking the Pick voxel option. The voxel object needs to be a geometry in the scene, and the user can just
pick it.
 
The Combine voxels based on material option, if checked, will combine all voxels, based on material, each in one geometry in the Object Tree.
If not checked each voxel will have its own geometry in the Object Tree.
 

 

  



 

 

To convert any 3d model to Voxelize model, Follow the steps below:

 

1.  First, export your model from any 3d software as one of the Supported Import Formats in Composer.
 
2.  Open the Composer, you can start the program by double-clicking its shortcut or from the start menu.
 
3.  To Import your model in Composer, click File → Import, or by using Ctrl+I, then select your model format and click Open.
 
4.  When you click Open, the Import File dialog will appear, In this dialog you can set different options for 3D import, select Z axis in up vector,
 Scale and Center, then click OK.
 
5.  Now your model imported in Composer.
 
6.  Select your model in Composer and click on Geometry → Voxelize Selection, the Voxelize Options dialog will appear, the default voxel
object is a cube of certain size, and you can choose a different object by clicking the pick voxel option then select another object  Ex: Sphere,
Cylinder or any object in the scene, then click Start.
 
7.  When the convert operation complete, the result will appear as a new object in Objects Tree.

The less the value entered in the cube size, the larger the size of the output file and thus the more processing power needed.



 

 

Boolean operations Group
 

 
Boolean Operations

 The boolean operations are smart tools that ease the process of performing simple modeling tasks within SimLab Composer and without the
need to go back to the cad design application.

  

 

 

#  Union boolean operation: removes the intersecting parts of objects or set of objects, while preserving the remaining part of the geometries.
#  Difference boolean operation:  deducts the shape and volume of one object or set of objects from another object or set of objects.
#  Intersrction boolean operation: preserves the intersecting parts of two objects or set of objects, while removing the remaining part of the
geometries.
 



 

 

 Simlab Composer aims to simplify the 3D visualization process for the user, offering powerful and easy to use tools that can significantly
improve the overall workflow, and allow the user to focus more on creativity rather than exhausting technicalities.



 

 

Material Menu
 

 
In this menu, the user needs to be able to apply materials for different objects in the 3D scene. Material task bar includes all the functions needed for
material application, and materials management.

  
 

  

Material system tutorial:



 

 

 

https://www.youtube.com/watch?time_continue=46&v=_miVD1W7TdA
https://www.youtube.com/watch?time_continue=46&v=_miVD1W7TdA


 

 

Scene Group
 

 
Show Materials

 This function button will display the Scene Materials dialog, which includes the material functions shown in the image below. Some of these functions are
included the Material task bar, others are found only in this dialog.

  
 

 
  

 

#  Delete Material: This function deletes the selected material, from the Scene Materials dialog. In case the material is being used by objects in the scene, a
dialog will appear asking the user to select a replacement material before the deletion.
#   Select Objects Using Material: This function selects all objects, in the scene using the selected material in the Scene Materials dialog. These objects-
geometry will be highlighted in the Object Tree, and in the 3D area.
#   Apply Material To Selected Objects: To use this function the user should select object(s) first, then select a material from the Scene Materials dialog or
the from the Material library. After that he can click this function button and the selected material will be applied to the selected objects.



 

 

#   Merge Identical Materials: In cases where more than one object in the 3D scene is using the same material, different copies of that material will appear
in the Scene Materials window. This function cleans the materials dialog from unnecessary duplicates.
#   Change View: This display option is available for the user to change the way the materials are displayed, in the Scene Materials dialog. They can be
displayed in Large, or Small icons, or can be shown as a list.
#   Sort by Name/Sort by Attributes: Two options for sorting the Scene Materials are available for the user.

  
Add New Material

 
This function creates a new default material-type, and adds it to the Scene Materials dialog. The new material with all of its properties will be shown in the
Properties panel of the application Interface.
 

 Delete Unused Materials

 Deletes all materials not referenced by any object in the scene. This function is also found in the Scene Materials dialog.
 

 Save as Library

 

After applying all materials for all geometry in a 3D scene, clicking this function will display the New Material Library window. In this window the user can
input a name for the new library then click Ok. This will save the applied scene materials in a library, and it will be shown in the Current Library combo-
box, and in the Manage Material Libraries panel.
 

 Retain from Library

 Before clicking this function button the user should first select the library to use, in the Current Library combo-box. This function will reapply materials
included in the selected library to the different geometry based on previously assigned materials names.

  

 
 
Retain from Library

  In cases where more than one object in the 3D scene is using the same material, Different copies of that material will appear in the Scene Materials
window. This function merge the same materials copies on one copy of material.



 

 

Library Group
 

 
Regenerate Library

 

 
•  Current Library: a menu list includes the default and user defined Material Libraries. Set to Composer as its default value. By selected the desired
library, the library and its contents will appear in the Library panel.
•  Manage: a button displays the Manage Material Libraries dialog box if clicked. In its dialog box, you can create new libraries, rename, delete,
export, import, merge existing libraries. You can also create new groups in the selected Library, rename and delete them.
•  Regenerate Library: a button, if clicked, will regenerate new icon/thumbnail images for the content of the corresponding library, for display
purpose only. A  warning message appears.
 

 

  



 

 

 

 
 
Style Only

 

 
This toggle button allows you to turn on or turn of applying styles (including properties such as color, glossiness, alpha, etc.) when dragging-and-
dropping a material from the Material Library onto a object in the 3D Area preserving texture information (including properties such as Texture,
Bump, and Normal).
 
 
This is done by clicking the Style Only button in the Material tab before starting to drag any material.

 
 
You can turn on or off the this option by clicking over the Style Only button

  



 

 

Material Palette Group
 

 
Material Palette

 SimLab Composer integration plugin is a great tool that allows you to create high quality renders for your design, and maintain a dynamic link where
you can simultaneously adjust the model and instantly update the changes in SimLab Composer.

  
 
This great feature allows you to resume your progress using the dynamic link between cad software and SimLab Composer without any losses.

 
 
Save Material Palette

 Material palettes is a useful feature that SimLab Composer provides, it can save your materials progress in a separate external file that can be
reapplied easily.

 
 
Go to the material tool, and select save material palette, set the path and the name of the file and click save.

 Reopen Cad Software and load the file you just saved. Go to the extension menu, then SimLab composer integration and select link with SimLab
Composer.

 As you can see the materials and textures applied in SimLab Composer, are the same materials applied in CAD Software.
  



 

 

 

  

 
 
Retain Material Palette

 Retaining the scene materials option, allows you to keep any materials you applied to the design in SimLab Composer. not having this option
toggled will re-import the original materials from CAD Software to the design.

  
 Select the palette file that you previously save, and set the mode to material name

 

  
 
Material palettes is another useful feature that simlab composer provides, it can save your materials progress in a separate external file that can be
reapplied easily.



 

 

UV Menu
 

 
UV

 Texturing is the process of applying an image to a 3D object, to give it a more realistic look. Texture Coordinate menu gives the user different options to
define the way the image is applied to an object.

  
 

  



 

 

Scene States Menu
 

 
Capture

 
Scene States enable users to capture different configurations for the selected 3D model(s), or for the whole scene. The User can check the properties
to include in a scene state, from the Default Apply group in this tool. SimLab Composer’s Scene States are smart in capturing attributes; they can
include any combination of the listed attributes. This can be helpful in creating scene states for models with different attributes, and setups.

  
 

  

 

The user can also set the width and height for the scene state preview Image, to match the settings in the export template.
With the properties checked, the user needs to click the Capture option, to be either From Scene or From Selection. The first option will capture
a scene state for the whole scene with the properties checked in the Default Apply group. The From Selection capture option captures a scene
state for the selected model(s), with the checked properties. Depending on the checked properties, the generated scene state will be added to the
corresponding tab(s) in the Scene States library.

 
 
Library

 A button, if clicked, will regenerate new icon/thumbnail images for the content of the corresponding library, for display purpose only. A  warning
message appears.

 
The Regenerate option will generate a rendered preview image for the selected scene state, with the size specified in the Preview Image group. The
Regenerate All option, will generates rendered preview images for all the scene states.
Scene states have many useful applications including;

 
 
Manage

 •  a button displays the Manage Material Libraries dialog box if clicked. In its dialog box, you can create new group, remove group, rename group. You
can also move groups up and down.

  



 

 

•  To Create a Scene States, Follow the steps below:

 

1. Open the Simlab Composer.
 
2. Import the model which you want to make Scene State on it.
 
3. Now, click Materials Library in Navigation Panel to view all materials in the library, then drag-and-drop desired material on the

model.
 
4. Select the object and click Scene States → Capture, the Scene State dialog will appear.

                                             
 



 

 

5.  In the dialog above, select Materials State then click Capture From Selection, now the state will appear in the
Scene States library in Navigator Panel, you can edit the state in Properties Panel below by one click on it.

                                   
 
6.  Repeat 3 and 4 steps to add more states, to show the state on the model click double on any state in Scene States library .

                                      
  



 

 

Also you can find a video tutorial to Create Scene States below.

 

https://www.youtube.com/watch?v=aaxtkQpCrnE
https://www.youtube.com/watch?v=aaxtkQpCrnE


 

 

Render Menu
 

 
SimLab Composer Real Time renderer (SimLab RT) is a powerful, fast, and easy to use real time renderer; that has full integration with SimLab
Composer. The renderer is optimally parallelized, so it can take advantage of all the CPUs available in the machine.

 

  
  

SimLab RT renderer is suitable for MCAD, interior rendering, producing top quality rendered images. To learn more about SimLab RT renderer, click
Help in the Setting/Help menu, and select Render Help.



 

 

Thanks to HDR Light Studio for providing us with high quality HDR images included in SimLab Composer.
  
 We released a new ISPC renderer for MaxOS
  
  

Rendering menu provides the user with all tasks necessary to create professional high quality rendered images/movies.
 

  

In the tutorial video below, we will show you how to importing a 3D model to SimLab Composer, then shows how to assign materials, After that the
tutorial teaches how to utilize rendering capabilities of SimLab Composer

 

https://www.youtube.com/watch?v=d8vmS1ZoxXE
https://www.youtube.com/watch?v=d8vmS1ZoxXE


 

 

Interactive Group
 

 
Real-time View

 Clicking this function will start real time rendering for the 3D scene, using the parameters in Render Settings. The function short-cut is F4, and RT
rendering can be stopped by un-toggling the Real Time function button or pressing F4.

  
 Real-time Clay Mode
 This function starts real time rendering in clay mode. Which is a real time rendering mode used for viewing the effect of lights in scenes, by changing all

materials, except glass and emitter materials, to gray matt.
  

 

                           



 

 

Fixed Group
 

 
Render Fixed Size

 This function starts real time rendering for the 3D scene, with a fixed image size. The image size used will be the one set in the Output Image task.

  

 

                    

 
 
Render Fixed Clay Size

 This function starts real time rendering in clay mode. Which is a real time rendering mode used for viewing the effect of lights in scenes, by changing all
materials, except glass and emitter materials, to gray matt.

  



 

 

 

                    



 

 

To File Group
 

 
Render to File

 
This type of rendering is time limited, with a fixed image size, as in Fixed-Render. The value to end/limit rendering time is SPP (Sample per Pixel)
value. This value can be found in Render Settings under the Output Image task.
A limited time rendering is automatically used by Animation Rendering, Scene States Rendering, and Render to File.

 
 
Render Clay to File

 
This type of rendering is time limited, with a fixed image size, as in Clay Fixed-Render. The value to end/limit rendering time is SPP (Sample per Pixel)
value. This value can be found in Render Settings under the Output Image task.
A limited time rendering is automatically used by Animation Rendering, Scene States Rendering, and Render to File.

 
 
Animation Render

 In a 3D scene with animation defined, clicking Animation function will start rendering animation. Animation rendering is a limited time rendering,
from the From Frame to the To Frame set in the corresponding spin-boxes, in the same task.

 
 
Sun Study

 This is useful for landscape designers, architects and interior designers. Simply from the render menu, the user selects Sun study, then defines the
initial and final sun states.

  



 

 

 

  
The study shows the sun and shadow states for the scene.

 
 
Scene States

 
For 3D scenes with scene states this function will start consecutive rendering for the scene states defined in the scene. Manage Scene States dialog
will appear for the user to check the scene states to render, and the order of rendering. Clicking Ok will start limited time rendering based on the SPP
value.

  

 VR Based Animation Rendering
 Rendering is a complex process that generates very realistic images, rendered images in many cases cannot be distinguished from photos.

Preforming complex rendering consumes a significant amount of time.
  

 
Users interested in previewing their work quickly, have a great new option in Composer 9. VR based rendering gives users great images in a very
short amount of time, This is great for multi-iterations, until the user is ready for the final animation render, for some users this may be the final
animation render they need.

  



 

 

VR based animation rendering demo video.

 

https://www.youtube.com/watch?v=F9DFtyKISQk
https://www.youtube.com/watch?v=F9DFtyKISQk


 

 

Package Group
 

 
Package Render

 Distribute rendering is supported in SimLab Composer. It allows the user to distribute rendering of complex animations, among a number of machines.
With the animation ‘*.sim’ file opened click Distribute function to open Distribute Render Animation dialog.

  

 

   
  

 Fill in the required settings, and then click the Generate Rendering Packages button. The output folder containing the packages will open, since the Open
containing folder option was checked in the dialog.

 



 

 

 A number of (*.srd) files equivalent to the number of machines input in the dialog, will be saved in the output folder.

 

 
Copy each file to a rendering machine that has SimLab Composer already installed. Click the Render function, in the Package group, to open its dialog.
Browse to the rendering package (*.srd) file, and select the output folder. Check the Open output folder option, and then click Start Rendering. A
rendering animation progress bar will continue to appear along with rendering menus until the animation rendering is done.

  

 

     



 

 

Setting Group
  

Environments Settings
 3D scenes require some sort of lighting, to give 3D scenes/models a more realistic look. Environments for rendering in SimLab RT can get lighting

from HDR, from Sun, or from lights and emitters defined in the scene. The user has the option mix and match between these light sources. This can
be done by enabling the HDR and the Sun each from its Render Settings dialog; this dialog has four tabs, described below;

  
HDR Environment

  
 

  
  

Clicking the HDR option will display its render Settings in the properties panel. HDR is the easiest method for achieving photo realistic views of
MCAD, and studio shots of a product, HDR’s are files of types (*.hdr) or (*.exr). Environment images are applied as a sphere surrounding the 3D scene.
They include light sources that are automatically used when rendering the 3D Scene.
To select an HDR file click the environment settings in the render menu. This will open a windows dialog where the user can browse to the HDR file to
use. Or just double click an HDR image from the library panel, to display the selected HDR, the user needs to make sure that the background is set to
Environment.

  



 

 

The color and brightness of the HDR image can be adjusted in the render settings dialog, and the new settings will automatically be saved and
applied. The user can also rotate the environment image, by adjusting its slider in the render settings dialog.
SimLab Composer provides a number of HDR environment images, free and commercial environment images can be used to extend the SimLab
Composer selection of environment images.

  
Sun Environment

  
 

  
  

This environment setting simulates physical sky at different sun angles (Solar Elevation), which determines the time of the day. The sliders of the
parameters of this environment option, makes it easy for the user to view the effect of each parameter, in real time.
The user can select to Enable Sun, in the render settings, in addition to enabling the HDR.

                                                      
 The user has multiple parameters to control the sky:

 
 #  Albedo: This parameter controls the effect of ground color reflection, which in turn affects the color and feel of the sky.

#  Turbidity: This parameter affects the clarity of the sky.
#  Solar Horizontal Angle: This parameter sets the rotation of the sun around the zenith.



 

 

Users not comfortable with specifying numerical values for Solar Elevation, and Solar Horizontal Angle, can add Sun Light for the Light toolbar.
Changing the direction of the sun, using its draggers, and then clicking the accept mark; will update the values in these two fields, if the Sun is
selected as the light source.
#  Sky Strength and Sun Strength: These two parameters can be used to increase/decrease the sky/sun strength effect on the rendered image.
More details about rendering parameters can be found in Renderer Help, under the Help menu in the Settings/Help Bar of the application interface.
#  Render Solar Disc: This check box option, when checked, will show the solar disc in the rendered image.

  
Ground

  
 

  
  

When setting the environment light source for rendering, the user has options for adding ground shadow and/or ground reflection to the 2D ground:
#  Ground Shadow: When clicked, its Render Settings will appear in the Tree/Task Panel. This option will generate shadows on the ground, and the
user can select the color and strength of the generated shadows. To apply the shadow settings to rendering, the user needs to check the Enable
Ground Shadow option.



 

 

#  Ground Reflection: Turns the ground into a reflective plane, where the user controls reflection color, roughness, and strength. The Enable Fresnel
option determines whether fresnel reflections are enabled or disabled. To simulate metallic looking reflections, Fresnel reflections should be disabled.
Environment Reflection option, reflects the scene’s environment when checked.
To apply the reflection settings to rendering, the user needs to check the Enable Ground Reflection option.                                             

  
Background

  
 

  
  

The background for rendering can be one of four options;
 # From Environment: Selecting this background option will apply Environment settings to the rendering background.
 # Single Color: With this background option the user can select a color to use for the background of the rendered image.
 # Background Image: This background setting option requires the user to browse to an image file to be used for the background of the rendered

image.
 # Spherical Background: enables the user to select (*.hdr), (*.exr), or any image file, that will be wrapped around a sphere or hemisphere, and select

color, size and brightness. This option is added to give users more control since the Environment-HDR (global HDR) in the Render Settings dialog can
be rotated, but cannot be scaled.

  



 

 

 Advanced Render Settings
 In this panel the user can set the main rendering parameters.

 

#  Rendering modes: SimLab Composer provides four types of rendering modes:
 o Fast Path Tracer.
 o MIS Path Tracer.
 o Interior Renderer.
 o Element Renderer.
#  Render Max Depth: is the number of ray bounces of the light. Increasing the number of ray bounces improves lighting for complex scenes,
especially diamond and glass scenes, but it slows rendering.
#  Automatic locking Time (seconds); is the time in seconds after which the image will be locked for navigation, in case of Real Time View rendering.
Setting this value to Zero will disable automatic locking.
#  Image ratio during navigation; is the ratio of the rendered image dimensions to use while navigating the scene.
#  Number of cores to be ignored; is the number of CPU cores not be used by the renderer. This is helpful when the user is working on other
applications while rendering. Setting this parameter to 0 will use all cores for rendering.

  

 

  
Settings related to the functionality of Interior Renderer Mode:

 
1. Light Depth: Set the amount of light energy.
2. Specular Depth: Control the visual appearance of specular reflections. It represents the amount of specular reflectivity a surface has.
 

The default values for both of Light Depth and Specular Depth (which is "3") are good and commonly used. Don't change this unless you really know
what you're doing.

  



 

 

Output Image Tab
 In this task bar the user can select the format for the output image and its dimensions.

 The properties panel will display Render Settings dialog. In this dialog the user can input the base file name, the output folder, and SPP to limit the
rendering. The open containing folder check option will open the output folder after finishing rendering.

  

 



 

 

Region Rendering
 

 
Region Rendering

 
It allows the user to check complex parts of the scene and see how they look like early in the rendering process, Using a small area of the scene to
determine the needed SPP for the scene.
Focusing rendering power in small areas that need more rendering to finish the process fast.

 

  

Region Rendering:

 

                           

https://www.youtube.com/watch?time_continue=14&v=aWRX1uE13N4
https://www.youtube.com/watch?time_continue=14&v=aWRX1uE13N4


 

 

Image Effect Menu
 

 
SimLab Composer provides its users with image post processing capabilities. Any combinations of image effects can be applied to a rendered image. In
this task the Tree/Task panel will display the Render Settings for the image.
 

 

                  

 
 
Vignetting

 This effect is a reduction of an image’s brightness/saturation, at the periphery of the image compared to its center.

 
 
Gray Scale

 This effect renders the image in gray scale.

 
 
Edges

 This effect renders the current model with edges shown.

 
 
Blooming



 

 

 A glow added to the rendered image. The user can change the Blur Radius, Brightness, and Opacity for this effect.

 
 
Cool, Warm and Saturation

 These image effects can be applied by setting a delta value, and they can be applied exclusively.
  



 

 

Texture Baking Workbench
 

  
Texture Baking workbench dedicated to bake textures of your 3Ds. Simply, Texture baking is the process of storing rendering results as textures.

  

 

  

 

Texture Baking, or Rendering to Texture, allows you to create texture maps based on an object's appearance in the rendered scene. The textures are
then baked into the object that is,
they become part of the object via mapping, and can be used to display the textured object rapidly on 3D devices such as graphics display cards or
game engines.
 
In other words, baked textures are those that have the highlights, shadows, and shading built into the texture. It would have the highlight of the body
built into the texture so it appears to
be more natural or realistic looking. Therefore, it is possible to use rendering algorithms in SimLab Composer to simulate shading, shadows and
bumps on the surface (or texture) of a
3D object. This process is commonly referred to as "baking" the texture. Texture baking refers to the calculation of environmental information (lights,
shadows, etc) and rendering that
information as a texture than can be used to make more realistic looking.

  

 

         



 

 

  

Basics of Texture Baking video tutorial:

 

https://www.youtube.com/watch?v=NqplUf-oaEU
https://www.youtube.com/watch?v=NqplUf-oaEU


 

 

Baking Menu
 

 
Baking Menu

 

This menu in the texture baking workbench, offers you the ability to use the smart baking system:
 

•  Smart Bake: Which is a tool that uses advanced calculations and algorithms that negate the effect of having a flipped object's
normal. while conventional texture baking softwares requires all the face       normals to be displayed properly for the baking process
to workout, SimLab Composer's smart baking offers you a smart solution to bypass that demanding step.
•  Object(s) Bake: which is similar to the traditional baking and will produce texture maps according to the face normals of the objects.

  

 

 
  

 **By clicking the Smart Bake button, the Texture Baking Setting dialog box appears (as shown in the following image), the following options can be
found in the Texture Baking Setting dialog box:

  

 

Texture Size:
Min: list menu 16, 32, 64, 128, 256, 512, 1024, 2048, or 4096 (in pixels).
Max: list meny 16, 32, 64, 128, 256, 512, 1024, 2048, or 4096 (in pixels).
 
Baking Quality:
Sample Per Pixel (SPP): controls the quality of the texture baking.
Dynamic Update (in SPP): controls at which rate should the texture baking results appear during the baking process.
Geometry Processing: fast or Top Quality
 
Optimize Baking Time: checkbox:
Polygons Per Object Limit: enter the number of ...

  



 

 

 

 
After confirming the baking settings by pressing OK, a progress box (as shown in the following image.) appears to reflect baking progress for each
object being baked in addition to the overall progress. Clicking the Next Object button will skip baking progress for the current object.
 

 



 

 

Baking Tools Menu
 
  

Baking Tools
 Show Baking group consist of the following:

 
•  Clean: you can clean the model of any baked texture.
•  Break Geometry: you can break the objects to faces or to geometries.
•  Break Faces: to break the selected 3D model into its faces. Each face will be converted to an geometry and appended to the Object Tree.
•  Merge on Material: with an assembly selected in the 3D Area or Object Tree, this tool will merge geometries that have the same material
into a single geometry.
•  Flip Normals: will reveres the face normals of an object in case the users wants to manually control the objects normals.
•  Info: displays important information such as the number of selected objects, and the number of vertices and polygons in a model.

 

 

  

Keep in mind that in baking, the material normals (which affect how light appears to reflect from the model's surface) can be recorded -- this results
in very specialized images with RGB values based on normal vectors.



 

 

Show Baked Menu
 

 
 
Show Baking

 
The show group contain a single task:
 

•  Show Baked: this option will switch the view between the regular model and the textured bake model.
  

 

      



 

 

Animation Workbench
  

The animation workbench in SimLab Composer offers multiple tools that facilitate animating objects and cameras in the 3D scene.

 The animation tools allow you animate objects and cameras, they also provide a way to create videos and movies as well as walk-
throughs.

  

 

  

Remember that the animation time line is activated.

 The time line is a dynamic diagram that holds editable keys denoting any animation created in the scene. You can also notice that the
animation time line is activated, the time line is a dynamic diagram that holds editable keys denoting any animation created in the scene.

 
 
Additionally, SimLab Composer can produce an image sequence of the animation and is able to convert the sequence to a video file that
can be easily viewed externally.



 

 

 

  

Animation video tutorial:



 

 

 

  

https://www.youtube.com/watch?v=y1J7AG9IXo0
https://www.youtube.com/watch?v=y1J7AG9IXo0


 

 

Object Menu
 

 
The object's animation menu holds several tools associated with animating an object, those presets assist the user in creating common object's
animation quickly and efficiently.

  

 

  



 

 

Object Animation Group
 

 
Show/Hide Object Animation

 Selecting a 3D object at any frame other than zero and clicking Hide from Object Animation group, will add a key frame at that location and the
object will be hidden there. Another key frame will be added at frame zero, with the object shown. Using these two functions hide/show animations
can be created easily.
 

 

  
Round Table

 

Round Table Object animation rotates the selected object by default, 360 degrees around the global z axis. The animation starts at frame 0 and ends
at the last specified frame. Selecting the green animation line of the object, in the Time Line, will display the animation parameters in the properties
panel of the application interface, as shown in the image below.
 
The user can select to change the Start/End frames, as well as the angle of rotation.
 



 

 

 

  

 
 
Wheel Animation

 

Wheel Animation is useful for rotating object(s) around a selected axis. To create wheel animation the user needs to select the object(s) to be rotated,
then to click this function button. In the image shown below one of the loader’s tires were selected. To be able to precisely select the wheel’s center,
change the pick mode to Pick Center of Curvature. This will generate edges for the whole scene and will select the center of the selected curvature
precisely. The wheel animation dialog will appear where the user can set the animation parameters.

 

 
Select the start frame for the animation, the end frame and the number of revolutions. Number of revolutions is the number of full rotations to be
done by the selected object(s). The user can also select the rotation direction to be Clockwise or Counter Clockwise the direction is determined using
the right hand rule around the rotation axis, always points out of the geometry.
 



 

 

 

 
 
Click Pick Center, and select the circle of the tire. The normal of the circle’s center will be highlighted, click the approve icon to end the process. As
can be seen in the image, an animation line for the Tier has been added to the time line.

 

 
Selecting this green line will display wheel animation parameters, in the Properties Panel of SimLab Composer interface. The user can change the
Start and End frames for the animation, as well as the angle of rotation. In the Wheel Animation dialog shown above, the Number of Revolutions was
set to 10. This will result in 10 * 360 = 3,600 angle of rotation.
 



 

 

 

 
Following the same steps, the user can create wheel animations to the other three tires of the loader.
 

 
 
Follow Path

 Path animation can be used to make an object follow a predefined path. This object can be a 3D object, a camera or a light in the scene.
  



 

 

 



 

 

Material Animation Group
 
  

Movie Textures are animated textures that are created from a video file, they can be applied to objects while being in the Animation workbench.
 

 

 
To add an animated texture, you have at first to select an object then click above the Movie button. The Material Animation dialog box appears (as
shown in the following image) asking the user to specify a movie and to enter inputs as desired.
 

 

 

 

The Material Animation dialog box consists of the following fields and buttons:
 

•  Movie: Browse and select the desired movie from your disk drive.
•  Movie Length: Enter the length of the movie (in seconds). This displays the the first n seconds of the selected movie.
•  Begin Frame: Determine the frame where you would like to start showing the texture in animation timeline.
•  End Frame: Determine the frame where you would like to finish showing the texture in animation time line.
•  OK: Confirm and accept settings.
•  Cancel: To abort the operation.

 

Supported file types are MP4, avi, or flv.

  



 

 

Camera Menu
  

In this Panel the user can create key frames camera animations, as well as use predefined camera animation functions.
  

 



 

 

Camera Animation Group
 

 
Capture Camera

 Captures the current view in the 3D area with an animated camera, and creates a key frame at the current location on the animation TimeLine.
  

Round Table
 This function creates a camera animation, for the whole scene, that rotates 360 degrees around the global Z axis. By default this animation starts at

frame 0 and ends at the last frame of the animation.
  

 

         

 
 
Helical

 Creates an animation that rotates the camera 360 degrees around the global Z axis, with translation from the current elevation of the camera to the
ground (Z = 0), suitable for showing high buildings.



 

 

 
 
Director Record

 
Director Camera gives the user the ability to create animations that combine views from multiple animated cameras/views, in a scene. Clicking the
Director Record button will create a new camera named director camera and adds it to the Object Tree. The director camera will start recording the
views from the existing camera in the active view.

 

           
  



 

 

Video Menu
  

The video's menu enables the user to capture from view, create videos .

 



 

 

Video Group
 

 

Create from View
 This function can be used to share animations created in SimLab Composer with others. The Viewer Video Export dialog will open, where the user can

select the frames to include in the generated video/images, or check the Full Animation option.
 
If the Generate Video option is not checked clicking the Create button will generate images, for all the selected key frames, in the render output
folder. When the Generate Video option is checked, video will be created using another application for creating videos.

  
If the Generate Video option is checked the user can choose an audio file to add to the generated movie. The video quality, frame rate, and output
formats can also be set in this dialog.
 

 

       
  

  



 

 

Movie Maker
 This function can be used to create videos of several output formats from sequential render images using the movie maker tool. The Viewer SimLab

Composer Movie maker dialog will open, where the user can select the frames to include in the generated video, it also adds audio files to the
generated movies.

  
 



 

 

Walk-through Menu
  

 The last tool available in the animation workbench, is the walk-through tool.
 

 A Walk-through is a type of animation that mimics a human walking around within the 3d scene, which with its varied options, offers
accurate control over the camera's movement that immensely improves your model's demonstration.

 
Walk-through in SimLab Composer differs from the Path Animation, where Walk-through don't require defining a path of the walk by drawing a line,
or assigning the camera to the path. In SimLab Composer, the term of a Walk-through isn't a camera that follows a path that you define.
 

  

Walk-Through tutorial:



 

 

 

https://www.youtube.com/watch?v=38dDDwIhGH0
https://www.youtube.com/watch?v=38dDDwIhGH0


 

 

Walk-through Group
 

 
Walkthrough

  In this part of SimLab Composer interface, the user can create and record full motion video tours of a location. Essentially, creating an
animated walkthrough with SimLab Composer is a four step process.

  
The steps for creating a Walkthrough are simplified as follows:

 

             1. Start and set walkthrough parameters
2. Go on Tour
3. Configure the Time
4. Render the Animation

  
Each of these steps is covered later in this section.

  

 

  

 
•  Start: The button allows you to open the Walk-through Parameters dialog box. This group of parameters controls dimensions and behavior of the
camera measured in meter, m/s,or rad/s, which you can set to define and describe the characteristics of the camera object that you will take on while
being in the scene.



 

 

•  Stop: When you are done with the tour in your scene, click over the Stop button in order to exit walk-through mode and return the normal
navigation mode for your scene.
•  Reset: This button allows you to reset the walk-through to its origins represented only in the initial start location and the initial orientation. 

The Walk-through feature includes several keystrokes for controlling the camera’s movement. The arrow keys move the camera forward, left, back,
and right. You can also use the Z and X keys to rotate the camera left and right. Pressing the Z or X keys while the camera is moving changes the
direction in which the camera points.

 
 
Walkthrough Parameters:

 
 
This panel is located at the rightmost on the Walk-through icon. You find the following buttons in the Walk-through panel, as shown in the following
image:

 

a.  Height: Set your length in meters, this value presents the length of your body that affects. In the scene, this affects your proceeding when
you encounter a low ceiling.
b.  Width: Select your width in meters, this value presents the width of your body. In the scene, this affects your proceeding when you
encounter a gap between two close objects.
c.  Movement Speed: Determine your movement speed in m/s (Meters Per Second). The higher value you assign, the faster you move.
d.  Rotational Speed: Specify your rotation speed in rad/s (Radians Per Second).
e.  Step Height: Set the height of your steps in meters while walking in the scene, this value shows the maximum object's height that you
can climb in scene.
f.  Create New Camera: You can select this checkbox to create a new camera to be dedicated to Walk-through, or leave it unselected to use
the Active Camera. Walkthrough can be performed using the Active Camera or a new created camera.
g.  Pick: Complete the dialog box and click the Pick button to accept the current settings. After the dialog box is closed, you'll have to pick
the start location and direction.
h.  Cancel: Click Cancel to abort task. This closes the dialog box without any changes.

 



 

 

 

 
Once you deploy the camera, the overall settings will be applied. A mode is enabled in which you can control the camera using the keyboard. Walk-
through feature moves through the scene like a first-person video game where collision detection is also enabled, how cool is that!
 

Beware of falling! Always ensures that the feet stay parallel to the ground or an object's surface at all times and can be used to walk over soft or
rough terrain. If that happened, just click the Reset button.

Cannot see your scene! Always, keep a logical ratio between the size of the camera and scene itself.
 

Hiding an object in the scene does not disable collision with that object during walk-through.
 

  



 

 

Walk-through Library
 

 

 
The Walkthrough library is where scene states are stored, they appear as thumbnail images. To store a scene state, you need to select Capture button
form the Walkthrough panel.
 
Capture: A newly added button (as shown in the following image) to the Walkthrough panel. It is used to capture a scene state of the current active
walkthrough.

  

 

  

 The toolbar of the Walkthrough library consists of the following buttons, as shown in the following image: 
 
Delete: To erase the select scene state from the Walkthrough library.
Delete All: To erase all scene states from the Walkthrough library.

  
In order to restore the 3D Area to the captured scene state, the user has two ways to do that:
 

•  Double clicking an image thumbnail in the Walkthrough library.



 

 

•  Dragging-and-dropping an image thumbnail into the 3D Area.
 
This will result in transforming the camera to match the scene state stored in it.

  

 as shown in the following image a Walkthrough library that contains five captured scene states.
 

 



 

 

Speed Group
 

 
Speed:

 Speed Group is located next to the Work-through group and displays the speed associated with the active walkthrough. You can change the
speed of the motion anytime with this toolbar.

 
 
Here is a closer look at the Movement Speed Toolbar that includes only one graphical control element, as shown in the following image:
 

 

 

 

 
•   Movement Speed: This horizontal slider lets you set or adjust a value by moving an indicator. This control is a horizontal slider with a handle that can
be moved right and left on a bar to select a value. The bar allows you to make adjustments to the Movement Speed value throughout a range of allowed
values. It allows you to alter the movement speed while being in the scene by decreasing it through dragging to the left (Slower) or increasing it through
dragging to the opposite direction (Faster).



 

 

Animation Recording Group
 

 
Recording:

 
In this group, two buttons are displayed to start and stop recording from the Graphical User Interface (GUI), as shown in the following image.
The Record toolbar provides flexible options to start and stop recorder associated with the active walk-through and depending on your set
up:

  

 

 

 

 
•    Start: Recording starts when you click the Start button. Use this button to manually start the recording.
•    Stop: To stop recording, click Stop button. You can always stop recorder manually. When you click Stop, a dialog box appears with the following
parameters (as shown in the following image):
    1. Starting frame: Specify the number of the frame where you want the animation starts from. 
    2. FPS (Frames per second): Determine the Frame Rate in which to produce unique consecutive images.
    3. Stop walk-through mode: A checkbox option enforces you to exit walk-through mode back to the Active Camera once Save button is clicked.
    4. Save: Save the recording settings
    5. Discard: Reject last recording session.
 

 



 

 

Capture to Libray Group
 

 
Capture to Library:

 The Walkthrough library is where scene states are stored, they appear as thumbnail images. To store a scene state, you need to select
Capture button form the Walkthrough panel.

 

 

 •  Capture: A newly added button (as shown in the following image) to the Walkthrough panel. It is used to capture a scene state of the current active
walkthrough.

  

 

 The Panel of the Walkthrough library consists of the following buttons, as shown in the following image:  
 
Delete: To erase the select scene state from the Walkthrough library.
Delete All: To erase all scene states from the Walkthrough library.



 

 

 
In order to restore the 3D Area to the captured scene state, the user has two ways to do that:
 

•  Double clicking an image thumbnail in the Walkthrough library.
•  Dragging-and-dropping an image thumbnail into the 3D Area.

 
This will result in transforming the camera to match the scene state stored in it.

  
  



 

 

Animation Timeline
 

 
Time Line provides the user with a tool to visualize and edit animation key frames. The time line is displayed by default in the Library panel of the
Animation workbench. Click the Show/Hide details button in the top right part of the time line, to show or hide the timeline details.

 

  
In the timeline the user can also set the animation duration, by setting the end key frame value.

  
The current frame is marked on the time line by a red vertical line. The names of the animated objects appear on the left part of the time line, clicking on
the name of any object automatically selects it in the 3D area.

  
The current frame is marked on the time line by a red vertical line. The names of the animated objects appear on the left part of the time line, clicking on
the name of any object automatically selects it in the 3D area.

 
 
The user can play animation by clicking the Play Animation button in the animation time line, or by hitting the Space Bar. The tool bar also includes the
tool buttons Go to First Frame (Shortcut Home) and Go to Last Frame (Shortcut End).

 



 

 

  
1. Capture Key frame for Object
2. Capture Key frame for Camera (Ctrl+K)
3. Director Record button, which can be used for managing animations from multiple cameras
4. Go to Previous Animation Key Frame of the Selected Entity
5. Go to Next Animation Key frame of the Selected Entity
6. Select All Key frame on Animation Time-line
7. Copy and move selected key frames
8. Move selected key frames
9. Delete selected key frames
10. Delete all animations
 

 

 11. Create an Animation Sequence
12. Show animation sequence list



 

 

 

 

13. Forward Play/Pause (Space)
14. Go to Last Frame of Working Area (End)
15. Backward Play/Pause (Ctrl+Space)
16. Go to First Frame of Working Area (Home)
17. Working Area Start
18. Current Time
19. Working Area End
20. Scale Time Line

  
 Animation Properties:

 
 
Clicking on an animation key frame on the time line will show its properties, in the Properties panel. The user can change these properties, for different
types of animation.

  
The user can also change the location of any key frame on the time line, by selecting then dragging it from a location to another.

  



 

 

Animation Auto Ease Options
 Animation Auto Ease Options:
 •  The auto ease options specifies the speed curve of an animation.
  

 •  SimLab composer comes with various predefined motions, a motion is type of composer generated animation that is used for creating predefined
animations such as round table, follow path wheel motions for selected object and round table and helical motions for cameras.

  

 
 (1)     Regular Keyframe
 (2)     Selected keyframe (appears in blue)
 (3)     Previous keyframe
 (4)     Next keyframe

  

 
 (1)     Regular keyframe
 (2)     Predefined keyframe
 (3)     Previous keyframe
 (4)     Next keyframe
 (5)     Selected Keyframe (appears in blue)
 (6)     Start frame
 (7)     End frame

  
 Regular keyframes:

 

•  SimLab composer presents three types of ease that automatically adjusts the influence into and out of a key frame to smooth out sudden changes
in translation, rotation and scale. these options are auto ease out, out ease in and auto ease. with these options users can ease speed of an object
when coming into or out of a key frame or both, where (auto ease out) is used is to ease speed coming out of a selected key frame, (auto ease in) is
used to a speed coming in to a selected key frame, and (ease) is used to a speed coming both into and out of a selected key frame.



 

 

 •  With animation ease options, you can easily achieve smoother and more realistic motion for geometries and camera in your 3D scenes.

  

 

Possible symbols for regular with  and without ease effect:
 

Icons Description
No Ease
•  Regular animation keyframe without any ease type applied
•  Maintain constant speed at the keyframe itself from the direction of previous keyframe.
•  Maintain constant speed from the keyframe itself to the direction of next keyframe

Ease out
•  Regular animation keyframe with ease out applied
•  Acceleration
•  Maintain constant speed at the keyframe itself from the direction of previous keyframe.
•  Accelerate (speed up or increase speed) from the keyframe itself to the direction of next keyframe.

Ease in
Deceleration
Regular animation keyframe
Decelerate (slowdown or decrease speed) at the keyframe itself to the direction of previous keyframe.
Maintain constant speed from the keyframe itself to the direction of next keyframe

 Ease
 Deceleration then acceleration
Regular animation keyframe
Decelerate (slowdown or decrease speed) at the keyframe itself to the direction of previous keyframe.
Accelerate (speed up or increase speed) from the keyframe itself to the direction of next keyframe.

  



 

 

 

 In the image above, The darker the red gradient color, the faster the object is.
  

 
•  The first keyframe of Box 2 has a speed of 0 with an influence of 100% on its right side. Auto Ease Out automatically adjusts the influence out of a
keyframe. The object gradually accelerates as it leaves first keyframe until it reaches last keyframe, where it reaches its maximum speed. Keep in mind
that Auto Ease Out requires an existing next keyframe in order to take effect.

  

 
•  The first keyframe of Box 3 has a speed of 0 with an influence of 100% on its left side.  Auto Ease In automatically adjusts the influence into a
keyframe.  The object starts at its maximum speed and slows down as it approaches last keyframe. Keep in mind that Auto Ease In requires an
existing previous keyframe in order to take effect

  

 
•  Both of first and last keyframes of Box 4 have a speed of 0 with an influence of 50% on right side of first frame and left side of last frame.  This
automatically adjusts the speed of change, where accelerates as animation retreats from the first keyframe until it reaches maximum speed at frame
number 10 and from there decelerates as animation advances toward the last keyframe.

  

 
•  The middle keyframe of Box 5 as a speed of 0 with an influence of 50% on both sides. The object slows down as it approaches middle keyframe, and
gradually accelerates as it leaves. Keep in mind that Auto Ease requires existing previous and next keyframes in order to take effect on both sides of
selected keyframe.

  

 Predefined Motions:
 •  SimLab Composer comes with various predefined motions.
  



 

 

 •  A Motion is a type of Composer-generated animation that is used for creating predefined animations such as Round Table, Follow Path, Wheel
motions for selected object, and Round table and helical motions for cameras.

  

 •  In case of predefined motions, start and end frames have a speed of 0 with a default influence of 25% on sides that falls within an animation
sequence itself.

  
 •  The symbol of predefined motion provides a simple visual representation that indicates the relative speed at each particular frame within it.
  

 

•  Possible parts of predefined symbols with one of ease effects:
The symbol of predefined motion on the animation time-line consists of:

- The animation sequence itself
- Start frame, which acts as a regular keyframe
- End frame, which also acts as another regular keyframe

  

 

Possible symbols for redefined keyframes with  and without ease effect:
 

Icons Description
No Ease
•  Start frame of a predefined animation keyframe
•  Maintain constant speed at the first frame of the keyframe itself from the direction of previous keyframe.
•  Maintain constant speed from the first frame of the keyframe itself to the direction of the end frame of the
keyframe itself.

No Ease
•  Predefined animation keyframe
•  End frame of a predefined animation keyframe
•  Maintain constant speed at the end frame of the keyframe itself from the direction of the first frame of the
keyframe itself.
•  Maintain constant speed from the end frame of the keyframe itself to the direction of the next keyframe.
Ease Out Acceleration
•  Start frame of a predefined animation keyframe
•  Maintain constant speed at the first frame of the keyframe itself from the direction of previous keyframe.
•  Accelerate (speed up or increase speed) from the first frame of the keyframe itself to the direction of the end
frame of the keyframe itself.



 

 

Ease in Deceleration
•  End frame of a predefined animation keyframe
•  Decelerate (slowdown or decrease speed) at the end frame of the keyframe itself from the direction of the first
frame of the keyframe itself.
•  Maintain constant speed from the end frame of the keyframe itself to the direction of the next keyframe.

Ease in Deceleration
•  Start frame of a predefined animation keyframe
•   Decelerate (slowdown or decrease speed) at the first frame of the keyframe itself from the direction of
previous keyframe.
•  Maintain constant speed from the first frame of the keyframe itself to the direction of the end frame of the
keyframe itself.
Ease out Acceleration
•   End frame of a predefined animation keyframe
•   Maintain constant speed at the end frame of the keyframe itself from the direction of the first frame of the
keyframe itself.
•   Accelerate (speed up or increase speed) from the end frame of the keyframe itself to the direction of next
keyframe.
Ease Deceleration the acceleration
•  Start frame of a predefined animation keyframe
•  Decelerate (slowdown or decrease speed) at the start frame of keyframe itself from the direction of previous
keyframe.
•  Accelerate (speed up or increase speed) from the start frame of the keyframe itself to the direction of end
frame of the keyframe itself.
Ease Deceleration then acceleration
•  End frame of a predefined animation keyframe
•  Decelerate (slowdown or decrease speed) at the end frame of the keyframe itself from the direction of the start
frame of the keyframe itself.
•  Accelerate (speed up or increase speed) from the end frame of the keyframe itself to the direction of next
keyframe.

  



 

 

 

•  Box 1 has predefined motion with no ease effects
•  Box 2 has predefined motion with ease out only.
•  Box 3 has predefined motion with ease in only.
•  Box 4 has predefined motion with ease out and ease in effects.

In the tutorial video below, we will show you how to use an animation auto ease types:

 

  

https://www.youtube.com/watch?v=mWRz64Cqa1w
https://www.youtube.com/watch?v=mWRz64Cqa1w


 

 

Sequence Timeline
  

An additional essential feature that Simlab Composer offers is creating animation sequences.
  

 
To create interactive sequences that can be implemented in the VR experience in the Simlab viewer. Go to the animation Tab to reveal
the
time line where we are going to manage the animation keyframes and sequences.

 

 

 Click on the “create sequence” icon, then Select the created key frames and Type in the name of the sequence and click “ok”.
 

 

 
To create different animation scene sequence simply switch the created keyframes to reverse the animation.
 



 

 

 
In this dialogue will appear inquiring whether you want to delete the keyframes from the timeline after the sequence creation.
 

Note that you can view the created sequences by switching to the sequences tab in the bottom panel, or by clicking on
"Show Animation Sequence List".

 

 

Show Animation Sequence List will appear, as you show in the image below:
•  Show as animation: If you delete the keyframe from the timeline, by clicking on this button you can return  the keyframe again on the
timeline.
•  Delete: To erase the selected sequence from the library.
•  Manage Groups: The Manage groups button launches the Manage groups dialog box o give the user options to create, delete and
rename Sequence groups.

 



 

 

  

Create Animation Sequences for VR:

 

https://www.youtube.com/watch?v=k-Yzn_PVSIA
https://www.youtube.com/watch?v=k-Yzn_PVSIA


 

 

Simulation Workbench
 

 
The Simulation Workbench can be available and accessed based on the acquired license. If you have already purchased the corresponding license,
you can find this workbench on the Workbenches Bar within SimLab Composer GUI (For more information about "Ordering and License", see related
section later in this manual).

  

 

  
 You can now use SimLab Composer 2015 (SP1) to model the behaviors of objects in 3-D space. Thanks to its powerful physics engine that allows

simulation of the way bodies of many types are affected by a variety of physical stimuli, provided to simulate physical systems such as Rigid-Body
Dynamics in real-time and considering collision detection. The Simulation Workbench is dedicated for executing physical and mechanical simulations
within SimLab Composer application.  It is designed in such a way that helps you easily create and simulate complex mechanisms which can be
imported from various file formats supported by SimLab Composer.

  
 as shown in the following image the workspace of the Simulation Workbench when the Solids panel is active by default. The workspace presents the

Simulation toolbar, the Geometries Tree, Solids Tree, and the Links Tree. The Simulation toolbar is placed at the top of the application window that
displays a large collection of commands in a visual layout through a tabbed interface, the Geometries Tree is placed on the left-side, while the Solids
Tree is grouped with the Links Tree on the right-side.



 

 

 

                                            
            

The Geometries Tree only appears when the Solids Tab is selected.

  
 The Simulation Tool composed of four menus, use these menus to navigate and switch among the sets of widgets. Solids are defined in the Solids

menu. In the Links menu, solids properties and relationships between each other are set  Finally, the simulation is controlled and performed in the
Simulation and interactive menu:
 

1.  Solids menu: Geometries are defined and classified, where each solid contains either one geometry or a group of geometries.
2.  Links menu: Properties of solids and relationships between each other are set.
3.  Simulation menu: Where simulation is controlled and executed.
4.  Interactive menu: to allow the user to control machines using a Keyboard, or a Joystick..

 
  



 

 

Simulation video Tutorial:

 

https://www.youtube.com/watch?v=XOLW0qhbvT8
https://www.youtube.com/watch?v=XOLW0qhbvT8


 

 

Solid Menu
 
  

The first step in creating  a simulation is converting your 3d design to solid parts that can be physically simulated, to do so, you can either manually
select the parts and convert them to solid, or you can click on “auto detect solids” and simlab composer will automatically detect the objects in your
scene and convert them to solids.

 
Keep in mind that the first step in every simulation project is to define and create solids from the original geometries of your model.

 The Solids Panel contains the following Menu, as shown in the following image:
 

•  Auto Detect Solids
•  Solid Creation
•  Appearance

Each of these Menu is covered in the following sections.
 



 

 

The Geometries Tree and the Models Library are associated with the Solids Tab. Once the Solids Tab is activated, they will be displayed on the left-
side and bottom of the application window, respectively.

Solids detection or creation is considered as a transitional stage. Therefore, solids and links properties are not editable while you are activating the
solids menu.



 

 

Auto Detection Group
 
  

Auto Detect solids:
  

•  Detect: You can take advantage of this helpful button for automatic detection for solids, this gadget is based on running a complex mechanism
that automatically define and classify a model's geometries and assembles into solids, where each solid contains either one geometry/assembly or a
group of geometries/assemblies.
 
The Auto Detect button helps the user automatically identify the solids in the model by running an algorithm that creates solids based on the objects
and geometries present

  

 
As shown in the following image the simulation workspace with an imported model before clicking the Detect button, where the Geometries Tree on
the left shows the original geometries of the objects in the model, and the Solids Tree on the right shows the created solids. Here, the Solids Tree is
still empty because there is no solids created yet.

  

 

  



 

 

If the imported  model is from an analytical file format like .STEP, this algorithm makes use of the solids hints already embedded in an object to
identify it as a solid.

In some cases, the automatic detection method may not meet what you are trying to seek during creating your solids. For this, the manual method
for creating solids gives you more control over solid creation.



 

 

Solid Creation Group
 
  

Auto Detect Solids:
 In some cases, you may need to have more control over solids creation rather than using the automatic detect function. Here comes the role of the

Creation Toolbar.
  

The Creation Toolbar displays two buttons to manually create and revert solids using the Graphical User Interface (GUI), as shown in the following image.
This toolbar provides options to do or undo solid creation for the selected geometry(s) or solid(s), respectively. The two buttons are:

 

 •  Single Solid: Create Solid button allows you to manually create corresponding solids from the selected geometry or assembly. You can select a geometry
or an assembly either using the Geometries Tree or from the 3D Area. You can also select multiple geometries from the Geometry Tree by holding the Ctrl
key on the keyboard and clicking the desired , then pressing the Create Solid button in order to create the desired solid. After clicking the Create Solid
button, only one solid will be created and all of its corresponding geometries will be disappeared from the Geometry Tree and moved to the Solids Tree.
•  Multiple Solid: Revert Sold button gives the user the option to undo the creation of a solid(s), by simply choosing the desired solid(s) to be reverted
from the Solids Tree, and then clicking the Revert Solid button. You can select a solid either using the Solids Tree or from the 3D Area. You can also select
multiple solids from the Solids Tree by holding the Ctrl key on the keyboard, then pressing the Revert Solid button in order to revert the desired solids.



 

 

Appearance Group
 
  

Appearance:
 Sometimes, you may want a certain object to inherit the movement of a specified solid without including it in the equations of motion used by the

corresponding solver, here the Manipulation Toolbar comes in handy. You find only one button in the Manipulation Toolbar, as shown in the following
image:

  
 

  
•  Add Visuals: This button allows you to attach selected object elements to an existing solid as visualization object for the visualization purposes
that do not included in the simulation's calculations. To add a visual, select the desired object(s) from the Geometry Tree, then click the Add Visuals
button. Once it is clicked, the Select Solid dialog box (as shown in the following image) appears asking you to select the desired solid that you want
to attach visuals to.

  
 

 
A solver is a component of SimLab Composer. SimLab Composer provides a library of solvers, each of which determines the time of the next
simulation step and applies a numerical method to solve the set of equations that represent the model.



 

 

 
The Visual Icon appears  next to the visual object's name in the Solids Tree. You can toggle this icon to turn it back as a normal object combined
within the solid.

 
Visual elements can be disabled or enabled in the Solids Tree only if the Solids Tab is activated.

  
Hide/ Show:

 Hide/Show Toolbar is considered a handy and cool tool while working in simulation:

•  Hide: It hides visible object(s) from the 3D Area.
•  Show: It displays hidden object(s) in the 3D Area.

 
This tool makes your work easier, if you exploit it while creating solids in complex models.



 

 

Simulation Tree
 

 
 
Simulation Workbench Tree:

 

There are three kinds of tree views in the Simulation Workspace:
 
•  Geometries Tree
•  Solids Tree
•  Links Tree

  

 

         



 

 

Geometries Tree
 

 
The Geometries Tree is a  graphical control element that presents a hierarchical outline view of geometry items existing in the scene. Each geometry
branch or node can have a number of subitems. This is often visualized by indentation in a list. A geometry can be expanded to reveal subitems, if any
exist, and collapsed to hide subitems. The Geometries Tree allows the user to easily manage and navigate geometry objects.

  
 As shown in the following image, the Geometries Tree is located at the left-side of the application window.

  

 

                       



 

 

Solids Tree
 
 The Solids Tree is a  graphical control element that presents a hierarchical outline view of solid items created in the scene. Each solid branch or node can

have a number of subitems. A solid can be expanded to reveal subitems, if any exist, and collapsed to hide subitems. The Solid Tree allows the user to
easily manage and navigate among solids for selection or property modifications.

  
 The Solids Tree is located at the right-side of the application window which is grouped with the Links Tree, the Solids Tree.
  
 

           



 

 

Links Tree
 
 The Links Tree is a  graphical control element that presents a list of created links connecting solids in the scene. The Links Tree allows the user to easily

manage and navigate among solids for selection or setting properties.
  

 The Solids Tree is located at the right-side of the application window which is grouped with the Solids Tree, as shown in the following image, the Links
Tree.

  

 

   



 

 

Models Library
 
 The Models Library acts as a container for pre-installed simulation models that come with the Simulation Edition of SimLab Composer, distributed

into three groups: Basic Physics Experiments, General, and Collision (as shown in the following image). It is located at the bottom for the Solids
workspace. You can choose any model of the provided sample just to run it as it is or edit it as you wish.

  

 

  
 The toolbar of the Models Library is located vertically at its left-side, presenting the following three buttons:
  
 •  Add New Item: The Add New Item button allows the user to add new created simulation model to any activated model tab within the Models

Library.
•  Delete Item: This command discards the selected model from the panel of the activated tab.
•  Manage Library: The Manage Library button launches the Manage Library dialog box to give the user options to create, delete and rename model
groups which are presented by tabs.
•  Download item: This task is the same as in the Material Panel described in Navigator Panel.
•  Share Contents: This task is the same as in the Material Panel described in Navigator Panel.
•  Change View:v This task is the same as in the Material Panel described in Navigator Panel.
 

The Models Library is only associated with the Solids tab; it appears once the Solids tab is activated. By default, it also appears when you switch to
the Simulation workbench.



 

 

As a start point, you can take a preview of what SimLab Simulation is capable of by start running the provided models.



 

 

Links Menu
 
 In simulation, the behavior of a solid is governed by two things, the first is the total external forces affecting it, and the second is the link that defines

the relationship between it and another different solid acts as constraint that are enforced by.
 
Using the Links Tool, you add joints, springs, forces, and torques to control the mechanism behavior. The Solids Tool contains the following Groups:
 

•  Joints Group.
•  Spring Group.
•  Force/Torque Group.

 
Each of these toolbars is covered in the following sections.

  

 



 

 

Ground always exist in simulation although it isn't visible to the user.

The Lock Icon is different in simulation. Locking an object makes it invulnerable against any external force.

In SimLab Composer, every simulation case requires creating solids but creating Links is optional (it depends on the nature of the simulation). A Link
defines the relationship of two solids to each other. Consider these prerequisites when you start every simulation project.

The simulation process is very conservative! Before you start building your simulation, make sure that you are satisfied with your model and you
don't want to modify it outside of the Simulation Workbench.



 

 

Joints Group
 
  

Joints:
 A joint is something like a hinge, which is used to connect two solids. It is a relationship that is enforced between two bodies so that they can only

have certain positions and orientations relative to each other. To create a joint between two solids, you must choose the type of joint from the Joints
Menu then the Joint Properties Panel will appear on the left-side.
 
Joints Group is the leftmost group on the Links menu. You find five buttons in this groups, as shown in the following image. A brief description of
each joint type, supported by the SimLab Composer's simulation engine, is given as follows:

•  Fixed: This type of joints maintains a fixed relative position and orientation between two solids. In practice, using this joint is rare. If you need two
bodies to be glued together, it is better to represent them as a single solid when deciding that both of the solids hold the same properties during the
simulation session.
•  Revolute: A revolute joint (also called pin joint) is a one-degree-of-freedom kinematic pair used in mechanisms. Revolute joints provide single-axis
rotation function used in many places such as door hinges, folding mechanisms, and other uni-axial rotation devices.
•  Prismatic: A prismatic joint (also called slider) provides a linear sliding movement between two bodies. The two joined solids have their rotation
held fixed relative to each other, and they can only move along a specified axis, chosen by the user while specifying the joint properties.
•  Spherical: A spherical joint (also called a ball and socket joint) is a joint in which the ball-shaped surface of a solid fits into the cup-like indentation
of another solid. This type of joint allows the solid to move in a 360 degree angle—with more freedom than other joints.
Cylindrical: A cylindrical joint is a two-degrees-of-freedom kinematic pair used in mechanisms. Cylindrical joints provide single-axis sliding function as
well as a single axis rotation, providing a way for two rigid bodies to translate and rotate freely.

Once you select a Joint, you have to set its properties in order to work appropriately.



 

 

Geometric Group
 

 
 
Geometric:

 

The Geometric groups concerns with shape, size, relative position of solids, and the properties of 3D space. To create a joint between two solids, you
must choose the type of joint from the Joints group then the Joint Properties Panel will appear on the left-side.
 
considers questions of relative position or spatial relationship of geometric figures and shapes.
 
Geometric group is located on the Links menu. You find two button in this toolbar, as shown in the following image. A brief description of  this button is
given as follows:

 

 •  Distance : creates a link between two solids based on maintaining a certain distance between them at all times during the simulation.
•  path: specify a path in the scene for the solid to follow during the simulation



 

 

Spring Group
 

 
 
Spring:

 Spring: This button allows you to create a spring as a link between two solids. A spring is an elastic object used to store mechanical energy.
 

 

Once you click upon the Spring Button, you have to set its properties in order to work properly.



 

 

Force/Torque Group
 
  

Force/Torque:
 In addition to joints and springs, you can affect the behavior of a certain solid by applying an external force or torque on it.

 
The Force/Torque group is located at the rightmost on the Links menu. You find the following two buttons in this groups, as shown in the following
image:

•  Force: This button allows you to apply an influence (push or pull) which tends to change the motion of an object including to begin moving from a
state of rest, i.e. to accelerate. In other words, a force can cause an object with mass to change its velocity. A force has both magnitude and direction.
•  Torque: This button allows you to apply an influence which produces changes in rotational speed of an object.

  

 

The Properties Panel of the Force/Torque appears at the left-side of the screen. Properties that are intersect by Force and Torque, as shown in the
following image:
 
•  Name: Where the user specifies a name for the new force or torque.
•  Mode: This section allows the user to interchange between force and torque modes.
•  Application Space: The user specifies whether the force or torque will follow the affected solid as it moves (Local), or stay static on the original point
of application (World).
•  Affected Solid: Where the user selects the affected solid.
•  Location: Where the user selects the application point and axis for force or torque, in addition to that the ability to flip the force or torque direction.
•  Magnitude Function: This edit button, if clicked, displays the Function Editor dialog box where the user specifies and selects the desired magnitude
function for force or torque.
 



 

 

 

  

 

The Force/Torque Function Editor dialog box appears, when you click over the edit button of the Magnitude Function. This dialog box is shared by
both of Force and Torque, it contains the following parameters:
 
•  Motion Function: Constant, Ramp, 3-4-5 Polynomial, Polynomial, Sine, Derivative, Integration, or Sequence.
•  Constant.
•  Ramp: Initial Value and Slope.
•  3-4-5 Polynomial: Amount of Displacement and Duration of Motion.
•  Polynomial: C0, C1, C2, C3, C4, and C5.
•  Sine: Amplitude, Phase, and Frequency.
•  Derivative: Choose Function.
•  Integration: Choose Function, Constant (C0), Lower Limit (X1), and Upper Limit (X2).
•  Sequence: Select Sequence.
Function Plot: Start, End, Step, Plot Area, and Update button.



 

 

The Function Editor dialog box of Magnitude Function for Force and Torque is the same Function Editor dialog box of Motor Function for Prismatic
and Revolute Joints.



 

 

Gears Group
 

 
 
Gears:

 

A Gear or Cogwheel is a rotating machine part having cut teeth, or cogs, which mesh with another toothed part to transmit torque, in most cases with
teeth on the one gear being of identical shape, and often also with that shape on the other gear. To create a gear between two solids, you must choose
the type of gear from the Gears group then the Gear Properties panel will appear on the left-side.
 
Gears group is located on the Links menu. You find two buttons in this groups, as shown in the following image. A brief description of  each button,
supported by the SimLab Composer's simulation engine, is given as follows:

•  Gear (Gear Train or Transmission): Two or more gears working in a sequence. such gear arrangements can produce a mechanical advantage
through a gear ratio and thus may be considered a simple machine. Geared devices can change the speed, torque, and direction of a power
source. The most common situation is for a gear to mesh with another gear.
•  Rack and Pinion: a gear can also mesh with a non-rotating toothed part, called a rack, thereby producing translation instead of rotation. A
rack is a toothed bar or rod that can be thought of as a sector gear with an infinitely large radius of curvature. Torque can be converted to linear
force by meshing a rack with a pinion: the pinion turns; the rack moves in a straight line. Such a mechanism is used in automobiles to convert
the rotation of the steering wheel into the left-to-right motion of the tie rod(s). Racks also feature in the theory of gear geometry, where, for
instance, the tooth shape of an interchangeable set of gears may be specified for the rack (infinite radius), and the tooth shapes for gears of
particular actual radii are then derived from that. The rack and pinion gear type is employed in a rack railway.



 

 

Pulley Group
 

 
 
Pulley:

 

A pulley is a wheel on an axle or shaft that is designed to support movement and change of direction of a cable or belt along its circumference. Pulleys
are used in a variety of ways to lift loads, apply forces, and to transmit power. To create a Pulley between two solids, you must choose the link type from
the Pulley toolbar then the Pulley Properties panel will appear on the left-side.
 
Pulley tgroup is the rightmost groupr on the Links menu. You find only one button in this group, as shown in the following image. A brief description of
the button, supported by the SimLab Composer's simulation engine, is given as follows:
 

•  Pulley: A pulley may also be called a sheave or drum and may have a groove between two flanges around its circumference. The drive element
of a pulley system can be a rope, cable, belt, or chain that runs over the pulley inside the groove.



 

 

Simulation Menu
 
 After defining the required solids and their relationships that connect each other using joints, forces and torques, now you are ready to perform the

simulation and see the results, this can be done after switching to the Simulation menub where simulation is controlled and executed.
 
After you finish setting up your project, switch to the Simulation menu where the simulation is controlled and executed. The Simulation menu contains
the following groups, as shown in the following image:
 

•  Start/Stop Menu.
•  Parameters Menu.
•  Collision Menu.
•  Post Processing Menu.

 
Each of these toolbars is covered in the following sections.
 

 



 

 

Start/Stop Group
 
  

Start/Stop:
 You can start or stop the run of a simulation by clicking over the Start/Stop button (as shown in the following image) .

 
•  Start/Stop: This toggle button allows you to choose one from two predefined options (Start and Stop). The icon of which changes with each click
and cycles between two states; the currently displayed value presents the next state.

 

Before you run the simulation, you may need to alter the default simulation setting to what fits the application of your project exercise (Simulation
Parameters are discussed in the next section "Parameters Group").



 

 

Parameters Group
 
  

Parameters:
 Often you need to change the simulation parameters before attempting to run a simulation or after stopping a simulation in order to configure the

settings to what suits your requirements. The Parameters Group is located next to the Start/Stop Group. You find only one button in this group, as shown
in the following image:
 
•  Parameters: The Parameters button allows you to set up options related to the utilized solver and other various general and advanced options.

 

 

The Simulation Parameter dialog box appears when the Parameters button is clicked. This dialog box is a preference pane contains multiple panels, using
tabs as a navigational widget for switching among three sets of settings. The three tabs are: General, Solver, and Advanced.
 
•  The General Tab includes the following setting fields, as shown in the following image:
 

 

 

1.  Time Step:  This numerical field used by the chosen solver to determine the time step (in seconds) between iterations; reducing this value often
produces more accurate results, but this requires executing additional calculations that affects the simulation speed and the size of the generated data.
The default value is 0.001.
2.  End time: This numerical field tells the selected solver at any time (in seconds) the simulation will be stopped. Its default value is 10.
3.  Recording Simulation Results: This numerical field is used to ignore storing parts of the simulation data, and only saves data at a point after each
interval specified (in time steps) by the user. It is usually used when the time step is very small, and the resulting data is very large. Its default value is 1.



 

 

4.  Gravity: X, Y, and Z: Specify (in m/s2: meter per second squared) the gravitational acceleration in X, Y, and Z directions. The default values are 0, 0,
-9.80, respectively.

  

 

•  The Solver Tab includes the following setting fields, as shown in the following image:
 

1.  Solver: Projected SOR, Multithreaded SOR, Projected SSOR, Projected Jacobi, Projected MINRES, Projected BB, Projected PCG, APGD, and DEM. (the
default solver is Projected MINRES)
2.  Integrator: Anitescu Stepper and Tasora Stepper (the default integrator is Tasora Stepper)
3.  Maximum Number of Velocity Iteration: (the default value is 30)
4.  Maximum Number of Stabilization Iteration: Only associated with the Tasora Stepper Integrator. (the default value is 10)
5.  Penetration Recovery Speed Limit: Only associated with the Anitescu Stepper Integrator (in m/s: meter per second) (the default value is 0.6)
6.  Young Modulus: Only associated with the DEM Solver, only enabled if the DEM Solver is chosen. (the default value is 200000)
 

 •  The Advanced Tab includes the following setting fields, as shown in the following image:
 



 

 

1.  Overrelaxation Factor: This option is associated with the following solvers: Projected SOR, Multithreaded SOR, Projected SSOR, and Projected Jacobi.
(the default value is 1)
2.  Sharpness Factor: This option is associated with the following solvers: Projected SOR, Multithreaded SOR, Projected SSOR, and Projected Jacobi. (the
default value is 1)
3.  Minimum Bounce Speed: This option is associated with with all of the Solvers (in m/s: meter per second). (the default value is 0.15)
4.  Use SimLab Advanced Collision System: (this checkbox is enabled by default)
5.  Enable Sleeping: (this checkbox is disabled by default)
 

 

•  The Visual Tab includes the following setting fields, as shown in the following image:
 

1.  Hide helpers during simulation.
 



 

 

Collision Group
 
  

Collision:
 You find only one button in the Collision group, as shown in the following image:

•  Enable All: This toggle button allows you to choose one from two predefined options (Enable All and Disable All). The icon of which changes with
each click and cycles between two states; the currently displayed value presents the state which will be applied if the the user clicked it. By default,
collision is disabled.
 

SimLab Composer allows you to enable and disable each Solid individually by using the its independent Solid Properties Panel.



 

 

Post Processing Group
 
  

Post Processing:
 The user can always benefit from the saved result of the most recent successful simulation, either in exporting it to animation or plotting its

generated data
on charts. The Post Processing group is located at the rightmost on the Simulation menu. You find only one button in this group, as shown in the
following image:
 

•  To Animation: The To Animation button automatically exports the simulation results of the latest simulation session as an animation in the
Animation Workbench.
•  Solid trace point: attaches a visual guide on a solid's surface, the trace point's movement can by analysed using plots to study the behavior of the
solid at that point.

In order to review or edit the frames of your recorded animation, go to the Animation Timeline which you can find at the bottom of the Animation
Workbench.

In order to plot your simulation data, go to the Charting Area, which you can find at the bottom of the Simulation Workbench.



 

 

Plotting Library
 
  

Plotting Library:
 For the purpose of simulation data analysis and post processing, the user can use this graphical technique for representing a simulation data set as a

graph, showing the relationship between two or more variables. The visual presentation of different functions is very useful for users who can quickly
derive an understanding as a short path to gaining insight in terms of testing assumptions, model selection, relationship identification, factor effect
determination, etc. as shown in the following image a Plotting Area of two graphs.

  
 The panel of the Plotting Library is located vertically at its left-side, presenting the following four buttons:
 

 •  Add New Plot Tab: This button allows the user to add a new plot tab to Plotting Library.
•  Delete Current Plot Tab: This button allows the user to delete the activated Plot Tab.
•  Manage Library: The user can add multiple graphs assigned to present the desired simulation data. Four types of chart formation are available, as
shown in the following image Single Plot, Dual Vertical Plots, Dual Horizontal Plots, and Four Plots.
•  Manage Curves: This launches the Manage Curves dialog box (as shown in the following image) letting the user to plot selected channel(s) on the
desired graph area.
 

The Plotting Area is only associated with the Simulation Tab; it appears at the bottom of the Simulation Workbench once the Simulation Tab is
activated.



 

 

Interactive Menu
 

 
Simulation mode is developed for real-time Interactive Simulation. The new version of SimLab Composer takes Simulation to the next level,
interactive simulation was added to allow the user to control machines using a Keyboard, or a Joystick.
 

 Designed to work with Xbox One Controller, and possibility to work with other game controllers such as PS3 game controller.
 

Interactive Simulation supports pointer devices, sliders, keyboards, and joysticks.

  

Tutorial for VR Interactive Simulation:



 

 

 

https://www.youtube.com/watch?v=W2m3qWO_gB4
https://www.youtube.com/watch?v=W2m3qWO_gB4


 

 

Start/Stop Group
 

 
 
Start/Stop:

 You can start or stop the run of a interactive simulation by clicking over the Start/Stop button (as shown in the following image):

 

 •  Start/Stop: Either to start or stop Interactive Simulation.
 

 



 

 

Interactive Simulation supports pointer devices, sliders, keyboards, and joysticks.



 

 

Desgin Group
 

 
 
Desgin:

 You find two button in the desgin group, as shown in the following image:

 

 
•  Design Panel: A button that launches the Interactive Physics Entities dialog box.
•  Parameters: A button that launches the Simulation Parameters dialog box.
 

 •  The Desgin Tab includes the following setting fields, as shown in the following image:
 

 

 

 
Plus: It is a button with green plus icon.
Minus: It is a button with green minus icon.
OK: To confirm and accept settings.



 

 

Cancel: To abort operation.
  

 
The interactive Simulation Parameter dialog box appears when the Parameters button is clicked. This dialog box is a preference pane contains
multiple panels, using tabs as a navigational widget for switching among three sets of settings. The three tabs are: General, Solver, and Advanced.
 

 

The Simulation Parameters dialog box is the same as the Simulation Parameters dialog box found in the Simulation Tab except for the General tab.

Interactive Simulation supports pointer devices, sliders, keyboards, and joysticks.



 

 

Forward (Support Sliders, Keyboard, and Console Controller)
 
  

 The Interactive mode for simulation supports game controllers in addition to the standard input peripherals.

  
 The Xbox One Controller is the primary controller for Microsoft Xbox One console. The Xbox One Controller is powered by 2 AA batteries, however,

the Micro USB port can be used to power the controller, instead of its wireless connectivity. 
  

 

(the Microsoft Xbox One controller)
  
 Also, the Sony PS3 Controller is the primary controller for Sony Playstation 3 console. The Sony Playstation Controller features an internal built-

in battery, however, the USB mini-B to USB-A cable can be used to connect the controller to PC by wire instead of its independent Bluetooth
connection.

  

 

(Sony Playstation controller)



 

 

SimLab Composer offers direct support for the controller of Microsoft xbox one. In the other hand, the controller of Sony PS3 requires a third-party
software to work properly with SimLab Composer on PC. For more information, contact us at (support@simlab-soft.com)

 Through GUI (Slider Bars)
  

 

Horizontal slider lets you set or adjust a value by moving an indicator. This control is a horizontal slider with a handle that can be moved right and
left on a bar to select a value. The bar allows you to make adjustments to rotation or speed value throughout a range of pre-defined values. It allows
you to alter the movement speed while being in the scene by decreasing it through dragging to the left (Slower) or increasing it through dragging
to the opposite direction (Faster).

Controller sticks are sensitive. So take advantage of this property when designing a panel of increase and decrease keys for the interactive entities for
controlling control functions



 

 

Automation Workbench
 
 Introduction:

 

SimLab Composer allows using Java Scripts to automate processes, Java script automation is supported in two modes:
 
1.  Command line (for batch processing for a large number of files)
2.  Interactive mode (from inside the GUI of SimLab Composer)

  

 

  

Scripting is supporting in the Ultimate edition of SimLab Composer

  
 Command line Java Scripts:

 

Java scripts can be run from the command line by using the following command
 
 
So if the user named the first script as example.js . And saved it in folder C:\Scripts, The user should use the following command
 
 

  
 Passing arguments to Java Scripts:
 Looking at the first example, the user defined on top of the java script the name of the file to be imported and the output image file.
  

 For this script to work as expected, it is the users responsibility to name and place the input file as "c:\\temp\\input.obj" and to make
sure the output file "c:\\temp\\output.png" is copied to another place before re-running the java script, so it is not overwritten.

 %22../../../../Scripts%22


 

 

 
Another option for the user it to use the input file name and the output image name as arguments as shown in the following scripting
 
To do this, instead of defining the variables on top of the script as done before, we can use the runtime.args functionality, as shown in
the following example:
 
Other than changing the first two lines, the rest of the script is just the same.
 
To use the argument based script as before the user should use the following command:
 
This allows the user to control the import file and output image on the command line.

  

 

runtime.args supports the following argument types:
•  String
•  Number
•  Color
•  Vector 3
•  String Array
•  Number Array
•  Color Array
•  Vector 3 Array
 

  
 My first Java Script:

The following script, imports a file, sets camera in a good position, and renders an image and saves it.

  
  
 Interactive Scripting - Running Java script interactively
 The user can run Java Scripts interactively in different ways:



 

 

 

1. Select a script from the scripting library, drag it, and drop it on the 3D area

 
2. Select a script from the library, then from the script menu, click Run



 

 

 
3. From Script menu, click new, type the Java Script code and then click Run



 

 

  
  
 Using UI Elements In Interactive Mode:

 

Interactive Java scripts allows the user to create a dialog from the script to collect needed data, supported types include:
 
•  DATA_TYPE_VALUE: value number
•  DATA_TYPE_STRING: string
•  DATA_TYPE_BOOL: boolean
•  DATA_TYPE_VECTOR3: vecotr 3
•  DATA_TYPE_RAY3: ray 3 (the user can enter the value or pick from the scene)
•  DATA_TYPE_NODE: scene node (the user can enter name, or select from the scene) DATA_TYPE_NODE_ARRAY: array of scene nodes
•  DATA_TYPE_COLOR: color
•  DATA_TYPE_FILENAME_OPEN: open file name



 

 

•  DATA_TYPE_FILENAME_SAVE: save file name
  

 The user can simply create GUI to collect users data by using the following command:
 

  

 
This script will simply create a frame and allow the user to input values of First and Last frames
 
Values set by the user will be defined in data[0] and data[1].

  

 

  
 The dialog above was created using the following script:



 

 

 

 The user can set any number of inputs needed for the java script to run, this script is taking multiple objects (Nodes) and two directions
which entered by user to copy these objects In two directions.

  

Find the all scripting commands for SimLab Composer online in this page.

  
  

http://www.simlab-soft.com/3d-products/docs/help/scripting/English/index.html


 

 

Debugging Java Scripts
 
 Debugging
 The integrated debugger in the interactive mode makes it easy for Java Script writer to follow the execution of the Java Script, and to

check the values of variables, which makes creating new Java scripts faster, and fixing issues in existing ones easier.
  

 

  
 Num Description



 

 

1 Code Widget: The code widget shows the code of the currently selected script. The widget displays an arrow in the
left margin, marking the code line that is being executed. Clicking in the margin of a line will cause a breakpoint to be
toggled at that line. A breakpoint has to be set on a line that contains an actual statement in order to be useful. When
an uncaught script exception occurs, the offending line will be shown with a red background.

2 Continue: Evaluation will resume normally.
 Step Into: Evaluation will resume until the next statement is reached.
 Step Over: Evaluation will resume until the next statement is reached; but if the current statement is a function call,

the debugger will treat it as a single statement.
 Step Out: Evaluation will resume until the current function exits and the next statement is reached.
 Run to New Script: Run until the first statement of a new script is reached.
 Run to Cursor: Run until the statement at the cursor is reached.

3 Scripts Widget: The scripts widget shows the scripts that are currently loaded in the script engine. Clicking on a
script will cause its code to be shown in the code widget. When a script is no longer referenced by the debugger
target it is removed from the scripts widget.

4 Breakpoints Widget: The breakpoints widget shows all the breakpoints that are set. A breakpoint can be disabled
or enabled by clicking the checkbox next to the breakpoint's ID (the ID is provided so that the breakpoint can be
manipulated through the console widget as well).

5 Console Widget: The console widget provides a command-line interface to the debugger's functionality, and
also serves as an interactive script interpreter. The set of commands and their syntax is inspired by GDB, the GNU
Debugger. Commands and script variables are auto-completed through the TAB key.

 Debug Output Widget: The debug output widget shows messages generated by the print() script function. Scripts
can use the special variables __FILE__ and __LINE__ to include the current location information in the messages.

 Error Log Widget: The error log widget shows error messages that have been generated. All uncaught exceptions
that occur in the engine will appear here.

6 Stack Widget: The stack widget shows a backtrace of the script execution state. Each row represents one frame in
the stack. A row contains the frame index (0 being the inner-most frame), the name of the script function, and the
location (file name and line number). To select a particular stack frame to inspect, click on its row.

7 Locals Widget: The locals widget shows the variables that are local to the currently selected stack frame; that is, the
properties of the objects in the scope chain and the this-object. Objects can be expanded, so that their properties can
be examined, recursively. Properties whose value has changed are shown in bold font.

  



 

 

For more info about Debugging Java Scripts please visit this page

  
  
  

  

  
  
  
  
  
  
  
  
  
  
  

  

  
  
  
  
  
  
  

  

  

http://doc.qt.io/archives/qt-4.8/qtscriptdebugger-manual.html#getting-started


 

 

  
  

  
  



 

 

Visual Scripting
 
 Visual Scripting

 

Visual Scripting tool in SimLab Composer is a tool created to minimize the programming effort for non-technical users with no
coding skills. Therefore, instead of writing the computer code in a text editor, the Visual Scripting tool allows the user to develop
her/his desired programs via block diagrams using a graphical user interface. This makes the code easier to be written as well as to
be understood: Any designer, artist or animator can read the diagrams easily and can quickly grasp the logic of the flow.

  

 Getting Started
 When you select the Visual Scripting tool from the automation workbench tools, the window will appear as shown in the figure

below. It contains four main parts:

 

 1)     Options for ‘Run’ the existing flow, ‘Create’ a new flow, ‘Open’ or ‘Save’ flows.
 2)     The ‘Main Object Groups Bar’, which includes the category titles of all the available sources and functions.
 3)     For each ‘Object Group’, corresponding ‘Sources’ and ‘Functions’ are available.
 4)     The ‘Work Space’, where blocks can be dragged, dropped and linked to create the desired flow charts.



 

 

 

 Any flow in Visual Scripting consists of three main components: Sources, Blocks and Connections.
  

 A) Sources:  Sources are used to define file paths and 3D nodes to be used as inputs for different blocks in the diagram. User can
find several source types in the sources tab.



 

 

 
B) Blocks: Blocks are basically functions that can take inputs and produce outputs. Each block performs a single process. For
example, the block in the left side in the previous figure takes an integer number as input and converts it to a string as an output.
User can find several block types categorized into different tabs throughout the main bar.

 

C) Connections:  Connections are used to make the whole flowchart meaningful by linking sources and blocks. Thus, they define
which sources and blocks are connected. Accordingly, they arrange the execution order of the block diagram. The green ports on
the blocks are not essential but they are very important to ensure the right execution order and to create dependencies between the
blocks. To make the process easier for users, ports on each block are colored based on the data type that should be passed through
them.

 
After completing the flow diagram, hit the run button to start the execution. A pop up message will appear once the execution is
complete. Flowcharts can be saved and shared to be used in different projects.
 

  

In this video tutorial below you can learn how to using the Visual Scripting tool in the SimLab Composer 9.1.



 

 

 

  

You can visit the Visual Scripting web page in our website by this link

 Running Flows from Command-line (with optional arguments)

 

The flows of SimLab Visual Scripting have the possibility to be executed from command -line interfaces, such as:
•      CMD on Microsoft Windows.
•      Terminal on macOS.
 
Optionally, data are passed as arguments through CLI to a flow in order to override particular sources’ default values. To make flow’s
sources accessible from CLI, the user should do the following:
1)     Open/create a flow with SimLab Visual Scripting.
2)     Toggle CLI button  corresponding to desired sources.
3)     Enter an identifier for the named argument key to be used in CLI.
 

https://www.youtube.com/watch?v=yROPc90VFGk
https://www.youtube.com/watch?v=yROPc90VFGk
http://simlab-soft.com/technologies/simlab-visual-scripting.aspx


 

 

[Command Syntax for Microsoft Windows]
SimLabComposer.exe {-fl <flow_file>} [ {-key1 <value1>} {-key2 <value2>} ]
 
[Command Syntax for macOS]
"/Applications/SimLab Composer 9.1.app/Contents/MacOS/SimLabComposer" {-fl <flow_file>} [ {-key1 <value1>} {-key2 <value2>} ]
or
open "/Applications/SimLab Composer 9.1.app/" --args {-fl <flow_file>} [ {-key1 <value1>} {-key2 <value2>} ]
 
 

 
In order to pass new width and length values to the above flow as arguments, the user needs to write in prompt a command-line
similar to
SimLabComposer.exe -fl flowFile.simlabvs -length 10 -width 20



 

 

VR Workbench
 

 
A VR workbench, dedicated to Virtual Reality (VR), has been added to SimLab Composer as the sixth workbench.
 

 The VR workbench contains the basic tools that are found in the scene building workbench along with the Animation workbench
since those tools can prove useful in preparing your scene for Virtual Reality viewing.

  

 Enrich your VR experience and add sound effects to everything (supported audio file format extensions are:  .mp3, .wav, and .ogg).

 

  
  

In the video tutorial below teaches users how to show mechanical models in an interactive VR experience.



 

 

 

SimLab VR

https://www.youtube.com/watch?v=hkG61zYAl8M
https://www.youtube.com/watch?v=hkG61zYAl8M
http://www.simlab-soft.com/use_cases/simlab-composer-vr.aspx


 

 

Visual Effects Menu
 

 
 
In the Visual effects menu, you will be able to create various dynamic visual elements that can further improve the realism in the VR
experience.

  

 

  



 

 

Visual Effects Group
 

 
Visual Effects

  

 

This function has the supported visual effects types in SimLab Composer, which are suitable for VR workbench. Users can create two types of visual
effects:
 

•  Create Web Browser: Create an active web browser screen in your VR scenes and projects.
•  Create Fire: Create fire from various presets and control its color and smoke for stunning visual effects in your VR scenes and projects.
•  Create Smoke: Create smoke from various presets and control its color for stunning visual effects in your VR scenes and projects.

 
 Create Web Browser:

 



 

 

 

This option allow the user to create the active web browser screen into the VR Viewer, when the user press on this option, a new object like a plane
named "VR Web Browser" will appear into the 3D area and into the objects tree, select it and go to Properties dialog, under the VR Web Browser tab,
add your web link into the URL field as shown in the image below, also the user can change the with and height the Web browser plane by using the
white point on it.

 

  
 Create Fire:

 
The fire effects let you create geometry that is camera-aligned. The objects always align to view default or connected camera. The plane
geometry linked to the fire effects will rotate around the local Z axis to face the viewer. The fire effects are centered on the object (plane)
which is linked to it.

  

 

To create Fire:
 

1.  Go To visual effects menu » Click the Create fire button on it.
2.  When setting the fire source for VR, the user has options for choosing the fire presets and choose (fire/smoke) color.

 



 

 

 

Fire is always kept aligned with the camera.

In object tree you will notice that the shape of the icon has changed to the fire shape.

 
 
Create Smoke:



 

 

 
The Smoke effects let you create geometry that is camera-aligned. The objects always align to view default or connected camera. The
plane geometry linked to the smoke effects will rotate around the local Z axis to face the viewer. The smoke effects are centered on the
object (plane) which is linked to it.

  

 

To create Smoke:
 

1.  Go To visual effects menu » Click the Create smoke button on it.
2.  When setting the smoke source for VR, the user has options for choosing the smoke presets and choose a smoke color.
 

 

In object tree you will notice that the shape of the icon has changed to the smoke shape.



 

 

Water Group
 

 
Make Water

 Make a realistic water surface and configure its color, depth, and speed in your scenes and projects.
 

 

To Make Water:
 

1.  Go To visual effects menu » Click the make water button on it.
2.  Select 3d object to become water.
3.  Go to launch viewer menu  » Click Start Desktop Viewer.

In object tree you will notice that the shape of the icon has changed to the ground shape.

 VR Water:

 



 

 

  
The water settings for VR workbench can be one of three options:

         # Water color: the user can select a color to use for the water.

 
        # Water Depth and Water Speed: These two parameters can be used to Make realistic water surface and configure its color,
depth, and speed.
 

 

 Remove Water

 

To Remove Water:
 

1.  Go To visual effects menu » Click the remove water button on it.
2.  Select 3d object to remove water.

 



 

 

After removing the water you notice that the shape of the icon has changed to its previous position.

 

 



 

 

Video Group
 

 
Make Video

 With Make Video effects, image sequences can be set as Textures (or Labels) to animate device displays,
The supported format at the moment is mp4.

 

  

To Make Video:

 

1.  Go To Visual Effects menu » Click the Make Video button on it.
2.  Select 3d object such as a screen to become a video.
3.  Now go to VR Video tab from 3d object properties in the Right side and select your video in the Video File field,
also you can set Play-On-Start, Interactive (play and pause when you click on the video in VR), loop and mute the sound, then start the VR
Viewer.



 

 

4.  Go to View menu  » Click Start Desktop Viewer.

  

 Remove Video

 

To Remove Video:
 

1.  Go To Visual Effects menu » Click the Remove Video button on it.
2.  Select 3d object to remove video.

 
  

 Also the user can using the Video Action in order to make an objects controlling on the Video into the VR mode, for example the user can make the
box object to pause, play, toggle, seek or play duration into VR, for more info about Video Actions in this section SimLab Actions.



 

 

Ground (VR Only) Group
 

 
Ground:

 Make object available for teleport.
 

 Press and hold to activate Teleportation mode. Then Release to teleport to a valid destination.
             # A red teleportation pointer indicates possible teleportation on an object.
             # A green teleportation pointer indicates forbidden teleportation on an object.

 

     

 
 
Remove Ground

 

To Remove Ground:
 

1.  Go To visual effects menu » Click the remove ground button on it.
2.  Select 3d object to remove water.



 

 

Clipping Plane

 

 Clipping Plane
 Also known as Section Plane in VR, it can be static, animated, grabbable, and turned on/off dynamically.
  



 

 

 

    

 
 
Make Clippable Object(s)

 Select objects to be clipped
  

 
Remove Clippable Object(s)

 Select clippable objects to be removed
  

In the tutorial video below, you can show how make clipping plane.



 

 

 

https://www.youtube.com/watch?time_continue=105&v=n03IDuBGlhU
https://www.youtube.com/watch?time_continue=105&v=n03IDuBGlhU


 

 

Actions Menu
  

In the Actions menu, you can manage VR Docks and grabbable objects.
  

 

  
  



 

 

Docking Group
 

 
Make Dock and Target

 Make dockable objects and interact with them in your scenes and projects.
 

 

   

Docking and target allows you to place moveable objects in a certain predefined manner upon interacting with them.

In object tree you will notice that the shape of the icon has changed to the Docking shape.

  In object tree you will notice that the shape of the icon has changed to the target shape.



 

 

 
 
Remove Dock and Target

 

To remove the dock and a target:
 

1.  Go To actions menu » Click the remove the dock and target button on it.
2.  Select the object to remove dock and target.
 

The docking systems in Simlab Composer offer you a great method to interact with components in your design.

Creating VR dock and a target video tutorials:



 

 

 

https://www.youtube.com/watch?v=ipIdD5ZVuD0
https://www.youtube.com/watch?v=ipIdD5ZVuD0


 

 

Grabbing Group
 

 
Make Grabbable

 Make grabbable objects and grab them in your scene and project.
 

 

    
 
•   The green highlight object in an assembly refers to the current available part of the system that you can remove.
•   The yellow highlight indicates that the object can be grabbed.
•   You will also notice a blue highlight on the assembly indicating that you can place the object in there.
 

 
Interacting with assemblies in the SimLab VR viewer is very simple, the colored outlines and highlights will guide you throughout the
assembly and diss-assembly process with ease and without any confusion.
 



 

 

 

Press “H” on your keyboard to toggle the hand. The hand has a fixed position at the center of the view, but can be moved away or
towards you using the mouse scroll.

Creating VR assembly/disassembly instructions:



 

 

 

  
 Grabbable Sequence

 

Grabbable sequence allow users to interaction with 3D objects in VR Viewer by linked these objects with animation sequence, In the image below,
create animation rotation for the control arm and saved it as sequence, then linked this sequence to arm object used grabbable sequence tool, the
arm can be picked up and control them up and down in VR Viewer.
 

https://www.youtube.com/watch?v=ipIdD5ZVuD0
https://www.youtube.com/watch?v=ipIdD5ZVuD0


 

 

 

  

  
 

To make grabbable sequence to object follow these steps:

 
1. In VR Workbench, select  Actions → Make Grabbable Sequence.

2. When The message below appear, select the object that want to make grabbable (create an Animation Sequence for it before) then click .



 

 

 

3. Now select the Animation Sequence for the object from Sequence Library then click .

 

4. Finally, Input scaling factor for object.

Press “H” on your keyboard to toggle the hand. The hand has a fixed position at the center of the view, but can be moved away or
towards you using the mouse scroll.



 

 

Preview video for Grabbable Sequence.

 

https://www.youtube.com/watch?v=7dtjZXjiavw
https://www.youtube.com/watch?v=7dtjZXjiavw


 

 

Disassembly Group
 

 
Manage Assembly Process:

 In the assembly management window you can graph and connect nodes based on the order you want them to be disassembled.
 

 

 

  
The assembly management interactions, settings:

 •   Green Plus button: Adds the selected node (in the 3d scene) to the disassembly diagram, if a disassembly graph node is selected, it will become
the parent of the newly added node.

 •  Ladder button: Change parent of selected disassembly graph nodes, a graph node must be selected before clicking this button, the graph node
selected afterwards will become the new parent - or - if a blank space is selected, the graph node will become independent (with no parent).

 •  Red Minus button: removes a node from the graph.
 •   Create new: create a new disassembly diagram.
 •  Rename: change the name of the disassembly diagram.
 •  Delete: remove the disassembly.
  



 

 

In the tutorial video below, you can show how used disassembled group.

 

https://www.youtube.com/watch?v=e9zgwvnLqhI
https://www.youtube.com/watch?v=e9zgwvnLqhI


 

 

Lists
 

 
Visualize Scene Options

 Visualize scene options (scene states and animation sequences) by displaying them as entities in 3D world for easier and practical VR
experiences.

 

Press "Alt" on your keyboard to show Pins, "LBUTTON" to select Scene States/Animation Sequences which appear as entities from the
Pins.



 

 

 

                                   

 Number Description



 

 

1  A Trigger displays Pins if interacted by the user in SimLab VR Viewer. To add a Trigger select a Scene Node
from Tree or from the 3D Area.

2 Remove a Trigger and eleminate any associated pins and scene options.
3 The list of Triggers.
4 Activate Scene States library to drag-and-drop Scene States into Pin nodes.
5 Activate Animation Sequences library to drag-and-drop Scene States into Pin nodes.
6 Add a Pin node to the current diagram, a Pin holds scene options chosen by the user. Once added, you can

drag-and-drop either Scene States or Animation Sequences from their corresponding libraries to it.
7 Remove the selected Pin node from its diagram.
8 Watch an online video tutorial about how to visualize scene options.
9 (VR List) you can drag-and-drop Scene States/Animation Sequences here from their corresponding libraries.

10 Scene States/Animation Sequences.
11 List Properties, you can choose the shapes to display Scene States/Animation Sequences in VR Viewer.

  
  

•  To create a Visualize Scene Options, Follow the steps below:

 

1. Open the SimLab Composer.
 
2. Before create a Lists, you must create multi Scene States/Animation Sequence (Create at least two).
 
3. When you finish the previous step, click Actions → Visualize Scene Options, the Visualize Scene Options dialog will appear.
 

4. Select the object which you want to make list for it Ex: Bedside Table, select the table model then Add a Trigger by click  
 
5. The object name (Bedside Table) should appear in the Pin and Scene Options side as shown in image below.



 

 

                                                                   

6. Now drag-and-drop Scene States/Animation Sequence (which created in step two) from Scene States Library into the VR List1  one by
one.

                     
 

7. The Scene States/Animation Sequence will appear under the VR List1  as shown in image below.



 

 

                                                        
 
8. You can change the name of list and choose the shapes to display Scene States/Animation Sequences in VR Viewer from List Properties when

click 

                                            
 

9. When you finish, click  to save changes.
  

In the Video below, you can show how to Visualize Scene Options for VR and Mobile.



 

 

 

https://www.youtube.com/watch?v=vaR9X_8ktP0&feature=youtu.be
https://www.youtube.com/watch?v=vaR9X_8ktP0&feature=youtu.be


 

 

Events
 

 
VR Native Events

 A state machine based system used for endless possibilities in your VR experiences, which includes location-based triggers.

 



 

 

                                   

 

1. Create new Event.
 
2. Copy the Event.
 
3. Delete the Event.
 
4. The lest of Events.
 
5. Edit Variables and Initial Values
 
6. The Event Types:

•  When the object entered object.
•  When the object exited object.
•  When the scene state applied.
•  When the sequence ended.
•  When variable condition changed.

 
7. Selection Node from Tree or from the 3D Area.
 
8. Zoom to object.
 
9. The lest of Responses.
 
10. Delete the Response.
 
11. Copy the Response.
 
12. Create new Response.
 
13. The Response Types:

•  Change action for object.
•  Apply scene state.
•  Change variable value.
•  Play sequence
•  Play sound



 

 

 
  
  
  
  

VR Drumming Demo using events and response system.

 

https://www.youtube.com/watch?v=UPNFLWVe0JY
https://www.youtube.com/watch?v=UPNFLWVe0JY


 

 

Light & Shadow Baking
 

 
New technology that stores lighting and shadow information with objects separately and away from their materials. It means that user can change
the material itself and/or modify its properties even change its texture without the need to re-bake it again and again.

 

  
 The image below show you the difference between disable and enable light baking



 

 

 

  
  

Using Light baking for superior Mobile VR



 

 

 

  

The user can switch between the two to experience day and night views by use Sun light or interior IES lights in the VR scene.

https://www.youtube.com/watch?time_continue=82&v=3uqPEkZNeug
https://www.youtube.com/watch?time_continue=82&v=3uqPEkZNeug


 

 

 

https://www.youtube.com/watch?v=sHpy4RYTIF8
https://www.youtube.com/watch?v=sHpy4RYTIF8


 

 

360 Image

 

 What is a 360 image?
 A 360 or a panorama image, is a special type of image that allows the user to experience being inside a 3D scene, the user can view the scene

on a mobile, or using Facebook or other viewers.
  



 

 

 

  
 How to create a 360 image?
 Creating a 360 image using SimLab Composer is very simple, first you need to create a VR camera, place it in the scene, then select the VR

camera, and render a 360 image.
  

This process is shown in the following tutorial .



 

 

 

  
 Sharing 360 images on facebook?
 Facebook has one extra restriction on 360 images to be automatically detected, width to height ratio should be 2 to 1, for example

if width is 2000, height on the image should be 1000
  
 How to embed and use a 360 image in a website?

 

•  Download photo-sphere-viewer JavaScript library.
•  Added it in your website files.
•  Embed the necessary JavaScript files needed such as: three.min.js, photo-sphere-viewer.js
•  Add CSS:

  

https://www.youtube.com/watch?v=UCJZVDArriM
https://www.youtube.com/watch?v=UCJZVDArriM


 

 

 

 •  In your body tag create container for 360 images:

 

 •  Then Include JavaScript Code:

 

 •  Finally it will look like this :



 

 

 

 For more details and examples on how to embed a 360 image in a website visit these links: Link 1, Link 2

SimLab 360

http://photo-sphere-viewer.js.org/
https://github.com/JeremyHeleine/Photo-Sphere-Viewer/find/master
http://www.simlab-soft.com/3d-products/360-help.aspx


 

 

High dynamic range images (HDR) Creation
  

HDR (High dynamic range images) or environment images, is one of the preferred methods to light a 3D scene for rendering.

 Originally those images were generated using specialized cameras, or through specialized software, due to the processes involved in
generating HDRs usually usually carry licenses preventing free distribution.

 SimLab Composer supports creating: 3D scene HDRs, Studio HDRs, HDR Studio, Created using SimLab Composer.
  

 

  
 Generating HDRs with SimLab Composer:

 

SimLab Composer makes it easy to generate HDR images, with the freedom of distributing them as any other rendered image created
using SimLab Composer, with the Composer 9.1, the user can create multiple 360 render image from the VR Viewer faster and easier without
consuming the processor for the device.
 
 



 

 

View the following tutorial to learn how to create HDR images using SimLab Composer.

 

  
 Sharing HDRs:

 If you generated a special HDR that you want to share with SimLab Composer users, please send an email to
support@simlab-soft.com and we will be glad to share it with the community.

  

SimLab HDR

https://www.youtube.com/watch?v=AgKBOoR3zWI
https://www.youtube.com/watch?v=AgKBOoR3zWI
http://www.simlab-soft.com/technologies/simlab-hdr.aspx


 

 

Teleportation Points
  

Use Teleportation Points to navigate large scenes fastly by activating the X-ray view in SimLab VR/Desktop Viewer.
  

This is a guide showing the user how to use the different methods: 1. Walk through 2. Teleportation

 

https://www.youtube.com/watch?v=z8mNut2ZeWQ
https://www.youtube.com/watch?v=z8mNut2ZeWQ


 

 

360s Grid Technology

 

 360s Grid Technology allow users to view the 360 images that have created and move among it in the VR Viewer
  

To use the 360s Grid Technology, Follow the steps below:

 1. First you must create VR cameras and make a 360 renders from it, select Create VR Camera from 360 Image Menu and move the camera to
properly location, doublecation the camera and add multiple cameras in the scene (At least two cameras).



 

 

From the output settings make sure the output ratio is two to one and the light specular depth is set to 100.

 2. Now select the render Multiple 360s from 360 Image menu to render 360 grid.

 

3. When the renders are finished, the render result will appear directly in the VR Camera Properties under (360 Section), in this section
you can preview and change the 360 image, also can make the render appear behind the walls as move among the 360 images in the VR
Viewer (it's Not Visible by default).

 4. Now, select Set 360 Start from 360 Image menu then select any 360 camera from 3d area to make it the first 360 image to be
displayed at the start VR Viewer.

 5. Finally, select Desktop Mode From View, the message below appear, select 360 then click OK.



 

 

  

360/Panorama Grid (How to create tutorial):

 

https://www.youtube.com/watch?v=AXO3aq61ADU
https://www.youtube.com/watch?v=AXO3aq61ADU


 

 

Viewer Menu
 

 
 
In the Visual effects menu, you will be able to create various dynamic visual elements that can further improve the realism in the VR
experience.

  

 

  



 

 

SimLab VR Viewer Group
 VR Viewer

 

In this part of VR workbench, you will find the ”Viewer” menu, where you can export your design as a 3D-VR file format, or you can directly
run the design either in Desktop or VR Mode. SimLab VR Viewer can be used by designers to share the VR experiences they create using
SimLab Composer with their clients. This program is all what is needed for the end user to view VR experiences. The hardware setup of
the end user is automatically detected, so the user can use HTC vive, Oculus rift is available, or the included desktop viewer.

 

  
  
 •  Show In VR Viewer

 
SimLab Composer comes with a special viewer that is developed to let users live and experience rich and interactive environments in two
navigation modes; SimLab Composer gives the ability to export and navigate created VR projects in a special purpose viewer in Desktop
Mode (i.e. Gaming controls using keyboard and mouse) and in VR Mode using modern VR peripherals.



 

 

 

  
 You can now enjoy the greatness of SimLab VR/Desktop on Mac (macOS greater or equal to 10.12).
  
 •  Add to Viewer

 
This option allow user to export the scene as a *.VRpackage format then add it into her\his account in the VR Viewer application directly ,
when the user clicks on this option the dialog below will appear.
 



 

 

 

 
In this dialog above, the user needs to insert a title, publisher name, preview image (855x465), and  description for the scene. This info
will appear on the scene in the VR Viewer, also the user can protect the scene by selecting the 'Protected' option. (Protected files can be
only viewed in SimLab VR Viewer, they can not be exported to other formats neither reopened by SimLab Composer).

  
 •  Open Viewer
 User can open the SimLab VR Viewer Application directly in SimLab Composer by selecting this option.
  

In this video below we will show you how to use the VR Viewer in SimLab Composer.



 

 

 

  

SimLab VR Viewer

https://youtu.be/UPPoj3gyfA0
https://youtu.be/UPPoj3gyfA0
http://www.simlab-soft.com/technologies/simlab-showroom.aspx


 

 

 

Navigation
 

 
Navigation in VR

 * Keyboard:

 You can use your computer's keyboard to move within prospect when paired with an HTC Vive. Here are the key mappings.
 

 1- Arrows:

 

    
 movement key:
 1.   Up arrow.
 2.  Down arrow.
 3.  Right  arrow.
 4.  Left arrow.

 
 
2- Advanced Options:

 

•    (H)   Hide/show hand.
•    (1)    Default
•    (2)    Apply Scene Building Mode
•    (3)    Show Pins (Lists)
•    (4)    View " Teleportation" points



 

 

•    (5)    Apply Measurement
•    (space) Jump.
 

 * Mouse:

 Use your mouse to interact with objects in the VR world.
 

 

 
 
1- Left Mouse Button:

 •  Press and hold to show a selection pointer on screen and activate highlight mode for objects that have actions (such as, Scene States,
Animation Sequences, Sound...etc) applied to them.

 
•   While the selection pointer is pointing on an object that has an action, release to activate the action.
•   Press and hold to grab the 'Grabbable' objects ( in Scene Building mode ).
 

 2- Right Mouse Button:
 •  Single click to activate the highlight mode for the 'Grabbable' objects.

  
 



 

 

 3- Scroll Wheel:

 

•  Move your hand closer or further.
•  By clicking middle-mouse button(Scroll Wheel), the GUI menu below will appear. In this menu, the user can find several useful options that
allows him/her to build the VR scene such as, editing materials and environments, adding notes, inserting models and objects into the VR scene
without going back and forth between SimLab Composer and SimLab VR Viewer again. The user can also save all changes directly from SimLab
VR Viewer.



 

 



 

 

1. Hide VR menu

2. VR Catalog

3. Material Editor: With the previous menu,the user can select any material from an object in SimLab VR Viewer by changing its color, material
type (Plastic, Metal, glass, Emitter and water), with the useful basic settings into the VR Viewer. Also, He/she can pick materials from the scene
and save them in the "Captured Materials" library using the "Eyedropper" tool. Moreover, he/she can apply the selected material from the library
on any object by selecting "Paint Brush" icon then pressing on the designated object. Lastly, you can delete the material by pressing the "Red X"
icon.

4. Environment Editor: This tool allows the user to make some adjustments and control the lighting of the environment for his/her scene. The
following image, there are four options included in this menu: Sun and Sky, HDR, Fog and Advanced settings.



 

 

 

 
•  Sun and Sky: In this option the user can enable/disable the sun and sky environment, and change between the day and night mode, also, he/
she can edit sun and sky attribute values and the sun color inside SimLab VR Viewer.



 

 

 
•  HDR: The user can enable/disable or even edit the light color and the brightness of the HDR through this menu.

 
•  Fog: Is a technique used to enhance the perception of distance by shading distant objects differently, the user can enable/disable, change color,
density and distance of the fog.



 

 

 
•  Advanced Settings: The user can edit the intensity of Lights, such as, Spot lights and IES lights which he/she created it before importing it into
the scene, also can change/choose the background to environment (HDR, Sun Light), single color or the image.

5. Navigation: There are three navigation modes inside SimLab VR Viewer: Walking, Flying and Mechanical mode.



 

 

 

 
•  Walking Mode: This mode allows the user to walk around inside the scene in player's First-Person view, the speed of the walk can be increased
by pressing and holding the Shift key while walking in the scene, also it can decreased by press the "Caps Lock" key button for once and back to
the normal speed by pressing it again.
 
•  Flying Mode: The User can fly like a bird in the viewer.
 
•  Mechanical Mode: This mode allows the user to turn the camera view around the center of the scene.
 

6. Notes: With this feature the user can create notes inside SimLab VR Viewer. This feature allows the user to place notes at any location in the
scene and save its position for later visits. Also, the user can include some notes using the keyboard, marking the objects or recording voice
memos.



 

 

 

 
•  In the "Notes" menu below the user can change the image preview of any note by pressing the "Capture View" button. Moreover, you can press
on "Pen" icon to start marking on objects and delete by holding right-click mouse button over it. Also, the user can Start/Stop recording his/her
voice memos by pressing the recording button. Lastly, the user can delete his/her records or voice memos by pressing on the trash icon.



 

 



 

 

7. Help

8. Save Scene: This option allows the user to save scene changes in SimLab VR Viewer as a .VRpackage or .EXE file.

9. Restart Scene: This option allows the user to restart the VR Viewer in order to go back to the start point.

10. Scene Building mode: This dedicated mode enables the user to move, rotate, scale, copy, delete, and hide/show objects in SimLab VR
Viewer.

 



 

 

 •  In this mode, the user can interact with VR scene elements using his/her two hands, also can grab objects as well.
  

 If the user clicks on  in SimLab VR Viewer, these icons below will appear:

Hide/Show object.

Replace object with another object.

Rescale object to its default size.

Make a copy from the object or duplicate.

Delete the object.

  

To be able to interact with objects in Scene Building mode, object must be made as Grabbable.

  

11. Lists mode (Visualized Scene Options)



 

 

12. Large Navigation mode: With this mode, the user can teleport among 360 cameras available inside the scene.

13. Apply Measurement mode: This mode allows the user to create and display the projected distance between 2 points in SimLab VR Viewer,
the default unit is Meter. To use this mode, press and hold left-click mouse button and move over any object in the viewer, release the button
when you are done.

 

 14. Exit, Maximize/Restore Down and Minimize SimLab VR Viewer Screen.



 

 

Start Desktop Viewer
 

 
Start Desktop viewer

 
The Desktop Viewer is where you can examine the VR experience without having to use the VR Head mount display and controllers, each
time you need to test the scene out, or in the case of not having a VR setup on the machine you are using.
 

 

  

 
 
You can now navigate through the scene in the Desktop viewer using the mouse and the keyboard, and you can assess the overall VR
experience for further modifications and improvements.

  

 

What's new in VR Viewer
•  Oculus Touch support
•  New mechanical navigation mode
•  AR
 



 

 

  

Press “escape” to exit SimLab viewer and go back to SimLab composer.



 

 

Start VR Viewer
 

 
Start VR viewer

 
The VR Viewer is where you can examine the VR experience with having to use the VR Head mount display and controllers, each time
you need to test the scene out, or in the case of having a VR setup on the machine you are using.
 

 

   

Make sure that you are using HTC 5 (VR).



 

 

 

Vive Controllers
 

 
Vive Controllers:

 Use the controllers to interact with objects in the VR world.
 

 

  
 

 1- Trackpad:
 •   Press and hold to activate Teleportation mode. Then Release to teleport to a valid destination.
  
 Note:



 

 

•    A red teleportation pointer indicates possible teleportation on an object.
•    A green teleportation pointer indicates forbidden teleportation on an object.
 

 

       
 

 2- System button:
 •   Fast press then release brings up the system main menu.
  
 3- Tracking sensor:
 •  Move controller and intersect with objects to highlight grabbable objects in VR Viewer.
 •  Move controller to desired direction and pick a jump point.
  

 4- Trigger:



 

 

 
•  Press and hold to shoot a continuous beam and point it to a desired object in order to distinguish by highlighting if an object
has action/action. Then Release, while the beam is still focused on a valid object, to activate actions such as Scene State, Animation
Sequences, and Sound effects.

 

             
  
 5- Grip button:
 •  Press and hold to enter grabbing mode and start grabbing valid objects.
 •  Fast press then release activates highlighting mode for grabbable objects in VR Viewer.



 

 

 

     
 

In the VR world, the two Vive controllers appear in different colors:
                   a. Blue controller is the main controller (marked with a blue sphere as demonstrated in the image below).
                    b. Green controller is the secondary controller.

 



 

 

Navigation tutorial for SimLab VR viewer video tutorial:

 

https://www.youtube.com/watch?v=c1_m5WBX3XE
https://www.youtube.com/watch?v=c1_m5WBX3XE


 

 

 

VR Viewer Application
 

 
VR Viewer Application

 
As another part of the SimLab VR framework for users, VR Viewer is an application that presents a professional way to store, manage,
exhibit, share your VR scenes and projects with others.
 

 

 
 
Using SimLab VR Viewer allows user to see the list of available 3D models on the left side of the framework, after selecting the models
the user can start desktop viewer or VR mode.



 

 

The user can access the online tutorial page by clicking on the image below on our website, for more tutorials: http://simlab-
soft.com/3d-products/simlab-composer-tutorials.aspx.

 

Adding the scene on VR Viewer is very simple to do that, export the model you want to share from SimLab Composer as a 
(*VRzim,*VRpackage) file, then adding the model on the Viewer.

 As you see in the image below,  User can filter the models out of tags.
 

 

  
There are several elements that provide structure to how the commands are presented in the User-Interface, as shown below.



 

 

 

 

 

•  Start Edit Mode: by clicking on this icon the user can add images, edit the title, the publisher and edit the description.
•  Upload Package:
•  Share Package:
•  Pack Package: This function button display "Pack the Scene" dialog, in which the user can create (*.VRpackage) file based on the selected file
format from the list.
•  Delete Package: by clicking this icon the user can delete the package from the list.
•  Edit Package Tags: by clicking this icon the user can remove or add tags.
•  Help: by clicking this icon the user can access the online tutorial page.

  
 Private Catalogs:

 
In the Free VR Viewer, users can now have two private catalogs, these catalogs contain the packages (up to 30 packages in each catalog
for private and public) that the user has added to those catalogs And share them with specific friends and users as a viewer by adding
their names and e-mail in the Viewer Management.

  



 

 

To create a private catalogs in Free VR Viewer, follow the steps below:

 1. Open the Free VR Viewer by double clicking its desktop shortcut or from the start menu.

 2. Press on  to login if you have an account, enter your email and password then press Log in, If you don't have account press

 and enter your information and password then press Register Now.

 3. In your account, select Manage Catalogs from the top right, the dialog below will appear.



 

 

 

 4. In this dialog above, press Add from Catalog Management to create a new catalog, you can create two, enter the catalog
information: catalog title, tags and logo image in the Catalog Info field.

 5. In the Viewer Info field, You can add more than one user who can view the packages within this catalog, to add viewer press Add and
enter the first name, last name and email for viewer, when you finish press Save.

 6. Now the catalogs which have been created will appear in this menu below, press into any catalog and add the packages into it.



 

 

 

Check out VR Viewer cloud client video tutorials:

 

  

https://www.youtube.com/watch?v=38rWu3J6kR0
https://www.youtube.com/watch?v=38rWu3J6kR0


 

 

In this video tutorial below we will show you how to using the VR Viewer to share VR experiences with users on the cloud.

 

https://www.youtube.com/watch?v=CDTTOwCfRss
https://www.youtube.com/watch?v=CDTTOwCfRss


 

 

Set Start Position
 

 
Changeable Start Position:

 In this part of VR workbench , the viewer start button will determine the starting location of your camera in the VR experience.
 

 
Click on “ Start Position”  to pick a starting location where you desire to start from in your scene and project. A human model is now loaded
into the scene, this human will represent the Viewer during the VR experience.
 



 

 

 

To quickly position the viewer start, press “N” on your keyboard, then click on the ground to snap the Character to the desired location.



 

 

You can then rotate the character to determine the angle at which the viewer will start.
 



 

 

Export Group
 

 
Export

 This function button will open the corresponding Export Geometry dialog. The export function enables the user to share the created 3D scene with
others in different formats.

  
 Clicking Export will display the Export Geometry dialog, where the user can share ZIM file with other , or to open it on the showroom.
  

 

  



 

 

VR/AR Mobile
 

 
VR/AR Mobile Viewer App

 
SimLab introduces a new and innovative mobile app for Android devices (iOS later) which allow user to live models and experiences
exported from SimLab Showroom, also users can view any 360 degree (Panorama) images rendered by SimLab Composer or any third
party.

  
 Features of the mobile VR viewer:

 

•  3D Viewer support: 3D View mode allows the user to view and share 3D models with others, The user can use finger gestures to
rotate and zoom the scene

•  VR experience support: VR mode allows using a mobile VR head set, to view 3D models in a VR experience.
•  Augmented Reality (AR): The AR mode allows the user to place a 3D model in a real environment while maintaining the full 3D

model interactivity.

Augmented Reality (AR) tutorial.



 

 

 

  
  

 •  Light baking support: To compensate for lower CPU power available on the mobile devices, without reducing output quality, SimLab
VR Mobile viewer supports reading light baking results generated using SimLab Composer.

Using Light baking for superior Mobile VR

https://www.youtube.com/watch?v=taPHGgrkwLY
https://www.youtube.com/watch?v=taPHGgrkwLY


 

 

 

  

•  To use our SimLab AR/VR Viewer application on the mobile or tablet, following the steps below:

 a. Install the SimLab AR/VR Viewer application from play store, when the installer finish open the application, the screen below will
appear.

https://www.youtube.com/watch?v=3uqPEkZNeug
https://www.youtube.com/watch?v=3uqPEkZNeug


 

 

 

      1) In this menu user can:

Back to previous screen.



 

 

 Exit from Application.

Go to application help.

 

     2) 3D Viewer Mode
     3) VR Viewer Mode with VR head set
     4) Augmented Reality (AR) Mode
     5) Add a new 3d model
     6) 3D Model
     7) 3D Model with 360 Grid Technology mark

  

 b. To add a new model, you must export (.vrpackage) file into the Device, Google Drive or Dropbox, then press Add 3D Model and
import the file.

When user import the model in the SimLab Application, it will appear automatically below its appropriate viewer mode, for example the
models that support the 360 Grid Technology will not appear below the AR Mode.

 c. Now, the model will appear in the screen, select the Viewer Mode at the top of the screen then Press on thumbnail of the scene to
access it, Use White circles at the corners of the bottom to look around and interact in 3D Viewer Mode.

  

SimLab Mobile Viewer

http://www.simlab-soft.com/technologies/simlab-mobile-viewer.aspx


 

 

Training Builder
 

 
VR Events Diagrams

 

VR training allow users to create an interactive environment inside the VR Viewer. It can integrate several inputs with built-in functions in
order to generate desirable reactions.  For example, when the VR viewer enters a specific area, an alarm sound plays or goes on. Inputs
can take the form of a Scene State, an Animation Sequence, a Scene Object, or an Action. Functions include events and responses that
are logically combined using the Boolean operations. For easier usability, functions are created using a diagram of smart blocks and
connections that link the corresponding components together in a visual scripting manner.

  
 Getting Started

 

When user selects the “Training Builder” option from the “VR Workbench” ribbon, a dialog box below appears, that contains the
following options:
1) The current/selected Diagram.
2) Create a new diagram.
3) Edit Variables and initial values.
4) Remove selected diagram.
5) All needed Inputs, events and responses functions and Boolean operations.
6) Unlimited working area.
7) Help.



 

 

 

  

 •  For better understanding this system, it should be read as an "If-then statement”. The User can add nodes, events, response functions and Boolean
operations by clicking on them or by drag and drop into the working area. The connection lines define the information flow of inputs-blocks-events.

  



 

 

 

Icons Inputs list  Icons Events List  Icons Responses List  Icons Booleans List

Sequence  If Scene Start  Then Apply Scene State  Variable Equals
String State

Scene State  If Scene State Applied  Then Play Sequence  Objects Overlap State

Scene Node
(object)

 If Sequence Ended  Then Stop Sequence  Object is Grabbed State

String  If Node Entered Node  Then Glow Object  And Operation

Variable  If Node Exited Node  Then Unglow Object  Or Operation

Action  If Node Triggered  Then Teleport to Camera  Not Operation

Boolean  If Node Grab Started  Then Show Message Box    

Sound File  If Node Grab Ended  Then Change
Node Action

   

   If Delay  Then Change Node
Grabable State

   

      Then Change
Variable Value

   

      Then Play Sound    

      Then  Video Action    

  



 

 

1. Let’s make a simple exercise using the Training Builder. The main aim of this exercise is to run an alarm system (light and buzzer) when the user
enters a specific area. To do so, we need to select the "Node Entered Node" from Events. Then we generate two nodes from the “Inputs” box: The first
one is for the user, and the second is for the specific area.

 

  

 2. Now select the user (viewer start position) from objects tree or directly from 3D area and press on this icon  to pick it up from the first node,
and select the specific area (you can make a specific area by creating a box and make the Alpha value equals zero for its material) and drop it into the
second node.



 

 

 

  

 
3. For connecting these two nodes together with "Node Entered Node" event just hold and press on the red point from first node and drop it in the
"SceneNodeA" red point in "Node Entered Node" event as shown in the image, and the second node with the "SceneNodeB" red point as shown in
the image below.

 

  
 4. The two nodes are now connected with the "Node Entered Node" event as shown below.



 

 

 

  

 

5. Now we need to add two different responses function: "Play Sequence" to start the light animation (you need to create an animation sequence
before) and "Play Sound" for buzzer, also add two inputs "Sequence" and "Sound File" to pick the light animation and the buzzer sound effect file on
them, then connect these inputs block with response functions, and "Node Entered Node" event with these two response functions by the same way
in the step 3.



 

 

 

  

 

•  In edit variables and initial values dialog below, user can define infinite numbers of variables and get values for them, the variable values must begin
with letters and can only contain letters, numbers and underscores. These variables can be used to maintain certain conditions such as, the status
of doors and windows (closed/opened), garage (empty/busy), engine (working/not working) and so on. Then these variables can change with event
functions inside the VR Viewer. 



 

 

 

  

The following video shows you an example for using VR Training Maker.



 

 

 

https://www.youtube.com/watch?v=_PI9HMQ8Bl8
https://www.youtube.com/watch?v=_PI9HMQ8Bl8


 

 

VR Catalog Menu
 

 
VR Catalog

 
With this feature the user can import ready models into the scene, such as, tables, chairs, doors, trees and much more directly into
the VR Viewer without need to go back to the Composer and run the viewer again. Also, she/he can add his/her own models into the
Catalog and share them with others online.

 

  



 

 

To create the VR Catalog inside the SimLab Composer VR Viewer follow the steps below:

 

1. Save all the models you want as a (.vrpackage) format into the same folder on your device as shown in the screenshot below:

2. Create a preview image (PNG) for your catalog to display it into the catalog menu in the VR Viewer, We recommend to create a square
image with size 256x256 px.
 
3. Go to the VR workbench select Generate Catalog from the VR Catalog Menu, the following dialog will appear:



 

 

 
4. In this dialog above, browse the folder which includes all the (.vrpackage) models which was created by step 1 as a Source Folder, and
then brwose the Preview Image (PNG) which was created in Step 2. Finally, enter the name for this catalog into the Catalog Name field,
then press Export, a new file (.vrcatalog) will be created in the Source Folder.
 
5. Go to the Environment Properties by clicking on the environment text from the object tree.

 
6. In the Environment Properties, scroll down to the Catalogs section and select Add From File (The folder icon) then select the
(.vrcatalog) file which was created in step 4 and press Open, the file location will appear in the image below.

Or you can upload the (.vrcatalog) file online on your website and add the URL link of it into the scene by pressing the green plus icon.



 

 

7. Now all the models will appear on the Catalog menu in the VR Viewer, with one click on the model you can insert it into the scene.
  

 VR Catalog List

 The user can add several catalogs into a list using  Generate Catalog List from the VR Catalog Menu.
The list will be exported as (.vrcataloglist) file, this file can be added and linked to VR scenes as the (.vrcatalog) file.

  

In this tutorial below we will show you how to create the VR catalog in the SimLab Composer 9.1.



 

 

 

  

You can visit the VR Catalog web page in our website by this link.

https://youtu.be/kTAm0VJPk1U
https://youtu.be/kTAm0VJPk1U
http://simlab-soft.com/technologies/simlab-vr-catalogs.aspx


 

 

Keyboard Shortcuts
 

 

Function Shortcut
Create New Scene [Ctrl] + [N]
Open Scene [Ctrl] + [O]
Save Scene [Ctrl] + [S]
Pack The Scene [Ctrl] + [P]

Import Geometry [Ctrl] + [I]
Export [Ctrl] + [E]
Exit [Ctrl] + [Q]
Undo [Ctrl] + [Z]
Redo [Ctrl] + [Y]
Make Instance [Ctrl] + [T]
Create Copy [Ctrl] + [C]
Show Scene Materials [Ctrl] + [M]
Capture Camera Key Frame [Ctrl] + [K]
Capture Scene State [Ctrl] + [D]
Geometrical Info [Ctrl] + [Shift] + [I]
Real Time View F4
Render to File F5
Select Esc
Move 2D 1
Move 3D 2
Uniform Scale 3
Show Pivot 4
Capture From Selection D
Freeze F
Snap To Ground G
Hide H
Snap To Object N



 

 

Pause Resume Render P
Show S
Unfreeze U
Delete     Del Del
Top View [Ctrl] + 1
Bottom View [Ctrl] + 2
Front View [Ctrl] + 3
Back View [Ctrl] + 4
Right View [Ctrl] + 5
Left View [Ctrl] + 6
Default View [Ctrl] + 7
Set Camera Target Vertex C
Set Camera Target Into Selected Geometry Center V
Fit All [Ctrl] + [F]
Zoom To Object [Ctrl] + [J]
Go To First Frame Home
Play Animation Space Bar
Go To Last Frame End
Move to Previous Frame -
Move 10 Frames Forward Page Up
Move 10 Frames Backward Page Down
Rubber Band Selection Alt
XRay View Alt + 1
Edges Only View Alt + 2
Solid Illustration View Alt + 3
Solid View Alt + 4
Append To Current Selection Alt + Ctrl
Remove From Current Selection Alt + Shift



 

 

 
 Contacts & Credits
 Product Website:

http://www.simlab-soft.com
 

Support E-mail:
support@simlab-soft.com

 
  
 To report any spelling mistakes, grammar mistakes or any errors, please contact us at info@simlab-soft.com

 
 Copyright © 2019 Simulation Lab Software L.L.C. All rights reserved.

Product is available at http://simlab-soft.com/3d-products/simlab-composer-trial.aspx

http://www.simlab-soft.com
mailto:support@simlab-soft.com
mailto:jsaid@simlab-soft.com
http://simlab-soft.com/3d-products/simlab-composer-trial.aspx


 

 

Ordering and License
 
 SimLab Composer is available in four editions: Educational/Hobbyist, Pro, Mechanical, and Ultimate. The Freeware edition does not need registering

and is free to use for both commercial and non-commercial purposes. The Professional, Floating, and Educational editions have a trial period during
which they can only be used for evaluation purposes. After this trial period, you must register the product or stop using it altogether.
 
You can instantly order any kind of the offered licenses for SimLab Composer at any time over the Internet with any major credit card, PayPal, purchase
order, wire transfer, phone order, fax order, check or cash.
 
After you purchased a license, you'll receive your personal registration code and the release version of SimLab Composer.
 
Please visit http://www.simlab-soft.com/3d-products/simlab-composer-buy.aspx for pricing information.
 
Here's what you can do with paid license of our product:
 

•  Remove watermark on the rendered images (depends on license type)
•  Free minor version upgrades
•  Free lifetime support. We promise prompt and courteous answers to your questions

 
 
Once you have ordered SimLab Composer registration key please enter it into the registration dialog box.

http://www.simlab-soft.com/3d-products/simlab-composer-buy.aspx


 

 

System Requirements
 
 Hardware and software requirements for installing SimLab Composer are as follows:

 
PC:
•  Intel or AMD processor
•  Any graphics card with 256 MB or more (either dedicated or shared)
•  2 GB of RAM or more
•  2 GB of free hard disk space
•  Monitor resolution of 1440 X 900 or greater
•  Windows 64-bit (7.8 or 10)
 
Mac:
•  Intel-based Mac, Core 2 Duo processor, or higher
•  2 GB of RAM or more
•  2 GB of free hard disk space
•  Monitor resolution of 1440 X 900 or greater
•  Mac OS X 10.9 or later



 

 

Feedback
 
If you have any comment/enquiry/feedback about our help please send it to us at: info@simlab-soft.com or support@simlab-soft.com
 
We would also appreciate if you fill our short survey about using SimLab Composer below:-
 
 
 
 
 
 
 

Thank you.
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